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Foreword

Until recently, I'd become resigned to the utter lack of humor with which
most of the microcomputer indusiry views its products, its customers, and
itself. If you don't know what I'm talking about, just take a look at the
“messages” that appear on your computer screen when you start using
some of today's more popular software. For instance, "FATAL ERROR F23"
or "ILLEGAL ARGUMENT TO DOS OPEN: CANT CONTINUE" doesn't make you

feel very cheerful.

Let's face it, it doesn't seem as if the programmers and software designers
who think up such messages are having any fun—at least not in the sense
that you and I might define the word. And for years, they and their ilk
have been frightening potential customers away from computers in droves.
But just in time, the Apple Macintosh computer has come along to

demonstrate that there is, after all, another way.

When you think about it, we really had no right to expect whimsy from
such an "important” machine. After all, the experis murmured
ponderously, the Macintosh project represented an atiempt to "redefine the
future of personal computing.” Other authorities—those concerned with
such matters as sales and marketing—warned that Apple would have to be
extremely careful, or it couldn’t hope to compete in the “"productivity

market” with IBM. And almost everybody agreed that the financial
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viability of the Apple Computer Company was totally dependent on the
successful launch of the Macintosh. Surely, then, this was no time for

foolishness.

But on the day the Macintosh was introduced, Steve Jobs, the chairman of
Apple, appeared before his stockholders and informed them that his new
machine was, as he put it, “insanely great.” And as users soon discovered,
there is whimsy galore built into “Mac” and its software, from the little
trash can icon you invoke when you want to dispose of unwanted data, to
the built-in puzzle you can instantly hide under a business document when
your boss comes along, to the option called Goodies—right next to such
"serious” choices as Bdit and File—which, among other things, lets you play
with the Macintosh’s graphics program as if it were a super-fast electronic

kaleidoscope.

What appeals to me most, however, is the variety of type fonts and styles
available on the Macintosh. When I first started to play with the MacWrite
and MacPaint programs, I thought back to a beginner’s printing press |
owned as a child. I remembered how I used to spend days fiddling with
tiny bits of rubber type, setting up a little brochure or greeting card. And I

was always thrilled with the results, even though the inking was uneven
and each line of text seemed to wobble all over the page. Now | had a

computer system that could do infinitely more than my old printing press

vi



could do—and it could do it perfectly, in just seconds. Here, in short, was a
machine with which I could do things that were fun—things very different
from spreadsheet analysis, balancing my checkbook, and all the other tasks

that home computers are supposed to be good for.

Which brings me, at last, to the subject of this book. I can't think of a more
appropriate writer to talk about the Macintosh than David Thornburg. Just
as Apple is perhaps the only major high-technology company with a sense
of humor, Dave is one of the few computer designers and educators I've
met who is blessed with a bona fide silly streak. Any doubts you may
have about this will be erased when, in the course of learning how to use
your Macintosh for the preparation of short reports, you suddenly find
yourself reading about Thornburg's revolutionary plan to manufacture
special heated compartments to keep bananas warm when they are put in
the refrigerator. Or consider the fact that, mixed in with all his genuinely -
useful hints for getting the most out of the Mac, he has included sugges-
tions for such useless applications as—to name but one—the automated
composition of ransom notes that look as if they were prepared by pasting

down letters cut out of a newspaper.

Finally, there's the matter of the names that pepper the sample documents
David Thornburg uses to illustrate his text. In Idea 12, for example, he
introduces us to Dr. Helen Wheels, Ph.D., inventor of the AutoErase black-
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board. In Idea I, we learn about the obscure, and presumably unpleas-
ant, town of Sunova Beach, California. And, once you've met him, how will
you ever forget Wayne Scott, President of Wayne Scott Paneling Company

("It’s not wainscot paneling if it’s not from Wayne Scott!)?

I was ecstatic when I encountered these people and places, because ['ve
always loved such names. Indeed, over the years, Muppet designer
Michael Frith and I have "discovered” such personalities as the seminal
saloon songstress Bertha de Blues, the aging (but talented) ballet master

Grandpa de Deux, and last but not least, the notorious bounder Juan

Formababi and his cousin Juan Morford de Reaude.
But you didn't buy this book to hear about these unlikely folks (or about
reclusive harridan Agatha Hellautaheere, either). So turn the page and

start finding out, as David Thornburg puts it, “just how useful and unique

the Macintosh computer really is.”

Christopher Cerf
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introduction

The revolution started in 1978.

That was the year thai personal computers were first sold to consumers.
Prior to then, computers were purely in the domain of the computer

professionals and a sparse scattering of wild-eyed hobbyists.

Prior to 1978, the idea that we might each have access 10 our own
computer was as foreign to most of us as the idea that we might each be
able 1o book passage on a space shutile—a dream at best. Bul the dream
was a nightmare for some. Even though 50,000 computers were sold that
year, many were purchased by people who didn't have the foggiest notion

of what to do with them.

The main problem with the personal computers of the late 1970s and early
1980s was that 10 use them effectively, you had to learn 10 deal on the
compulier'’s terms. You didn't have 1o become a raving technoid, but the
more you knew about things like syzes and bavd, RAM and FOM, the
better off you were. If you couldn'i find a program to do what you wanted,
you were encouraged to learn a language like BASIC so you could write

your own.
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Though this was a great improvement over the pure hobby days of
personal computers, many of us didn't have the energy or time to become
sufficiently versed in computer technology to put these machines to their
best use. But while some of us were busy hacking away at the
idiosyncrasies of our personal computers, another vision was being
developed. This vision promised a computational environment in which
computers were controlled by people who wanted to tell the computer
what 1o do, not Aow to doit. This seemingly simple distinction has
profound consequences for both the people who design computers and the
people who design the programs that run on them. The full-time effort of
hundreds of computer scientists was devoted to this task for over a decade
at places like the Xerox Palo Alto Research Center. Progress was slow but
steady, and some of these people transplanted their vision into a company

named Apple, where it took root and bloomed into a new computer.

The revolution came 1o the rest of us in 1984 with the introduction of the

Apple Macintosh.™

Macintosh is different. It is different from any other computer made by
Apple. It is different from any computer made by IBM. It is different from
any computer made by any other computer manufacturer in the personal

computer marketplace.



As someone who has been in the personal computer industiry for many
years (and has written about it for much of that time), I thought I should
write a book about the Macintosh. Not a "Gollyorkins, Mr. Wizard, let's all
clap hands and praise the Macintosh” type of book but a "meat and
potatoes” practical guide for people who wouldn't normally use a computer
for anything This would be a book for people who create documents,
make simple charts and illustrations—a book, quite simply, for the great
majority of us who might want 1o #se a computer but who surely don't

want to learn how computers work.

The challenge was to think of the right form this book should take. Clearly,
it should be useful to the reader, and it should cover topics not explored in

the manuals that accompany the computer.

As I was thinking about the book I had an idea. [ use my Macintosh
almost every day. And in the course of using it, | have found some
interesting ways to use it—=ways that are very different from the ways |
use my other computers, ways that are different from the ways | have
ever used word processors or graphics systems. Some of these are very
practical, and some of them are frivolous. But all of them can be used to

show just how useful and unique the Macintosh computer really is.
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When I started listing the ideas I had for using the Macintosh, it occurred
to me that I could go on listing them forever. That would make a very long
book, so I decided to pick a number—101-and stick with it. No more and
no less. With this many applications to choose from, I thought you might to
find a few that are useful, a few that make you laugh, and a few that

stimulate you to create even more applications of your own.

Thumb through the ideas, pick one at random, try it out. Experiment with

your Macintosh. It won't let you down.

I find the Macintosh so useful, I even used it to write this book.

Acknowledgement and disclaimer

I want to thank the Xerox Palo Alto Research Center who, by giving me
access o their Alto computers, gave me a 10-year head start on creating
projects for the Macintosh. It is also a privilege to acknowledge the people
at Apple who had the vision, courage, and skill 1o create a product of
Macintosh’s power while other computer manufacturers were producing
embellishments on older products. Guy Kawasaki's business card at Apple
lists him as a "software evangelist.” He is more than that. He has pulled

me out of several tight spots, including the time when [ was in the middle
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of this book and my office was stripped clean of all its Apple computers by
a midnight prowler. Thanks to Guy's help, I was able to continue my work

with minimal delay. Thanks, Guy, I really appreciate your support.

The names of people and places in this book were the products of several
minds besides my own: those of my son Harvey, my wonderful wife Pam,
her mother Virginia Howe, and her aunts, Barbara Hugo, Gerry Rhodes, and

Win Murphy.

With respect to the names and subject matter of this book, please know
that all people and place names are fictional, as are many of the activities.
My function in this book is to show a sampling of the wide variety of the
applications to which the Macintosh is particularly well suited and to
stimulate you to find new applications on your own. Rather than take a
ponderous approach, I elected to choose a more entertaining path. In no
case was il my intent to degrade any person, race, culture, galactic empire,
or universe; nor was it my inient to incite or instigate antisocial behavior
including, but not limited to, kidnapping, arson, treason, overtipping a
waitress because of her low-cut uniform, and the start of thermonuclear

war.

Gee, 1 just want us to have fun!

XiX



Chapter 1

THE MEANING OF MACINTOSH

This chapter provides some background on the characteristics that make
the Macintosh different from any other computer in its price range. Unlike
the rest of this book, its tone is philosophical rather than practical. If you
don't give a bean about the philosophy behind this computer, but simply
want to get on with the practical stuff, feel free to skip ahead to Chapter 2

and beyond—my feelings won't be hurt.

On the other hand, you may be one of those people who wants 1o know
why the Macintosh is so different from other personal computers. If you

are one of these people, this chapter is for you.



User control: YTelling the computer wA«7 instead of Sow

It has been called "the computer for the rest of us,” the automatic
transmission of computers, a computer you can master in 30 minutes, and
many other things. It is hard, on a purely rational rational basis, to see
why grown people are jumping up and down over the introduction of a
plastic box filled with computer chips—a box that in some ways resembles
the myriad other boxes that make up the products we call personal

computers.

And yet, hidden in the many articles that attended the introduction of the
Macintosh, there was a growing suspicion that whatever Apple had done
they had done differently from any other computer manufacturer creating
products in this price range. For some writers, this difference was
wonderful; for others it spelled disaster for Apple. Given that there will
always be more opinions than pundits to write them, it was not surprising
to see a mixture of hoopla and gloom in the press. Some of the positive
comments overstated the capabilities of the Mactintosh, and some of the
criticisms showed the limitations of the authors’ views rather than those of
the Macintosh.

The reality of Macintosh, like so many other realities in our world, is a
mixture of these two extremes. The Macintosh has its features 224 its

limitations. As with cars, boats, houses, and any other product on the



market, one can find things about it that are simply wonderful and others

that one would change, given the opportunity.

But beyond the pros and cons, beyond the hype and misguided criticism,
beyond the roar of the advertising and the clamor of the Mac's detractors,
there remains one central fact: Macintosh will change how we think about

computing.

Prior to Macintosh, people who wanted to use computers needed to learn

about computing per se. Bach machine and program had its idiosyncrasies

to contend with. Mysterious sequences of keystrokes were needed as

incantations to breathe life into otherwise dead computers. We took pride

in our special knowledge:

“Hey, I can’t get my machine to boot.”

"No sweat, bit breath, turn it on, type Control B, press RETURN, type PR#6,
and press RETURN again.”

“Thank you, O powerful master, it is working now."

“Don't mention it."

~ Dialogues of this sort—the sharing of secret handshakes among an elite group
~were commonplace prior to the introduction of the Macintosh. The fact that
computers needed special commands somehow made their users special too.
But Macintosh changed all that. Now you didn't have to know (or even
care) about computers to use one. Suddenly, English majors could use

computers as easily as engineers. What kind of fun was that?



The advent of the Macintosh marked the loss of the secret handshake.
Word was out that computers could be used by anyone, regardless of
background. The key to this transition was a paradigm shift—a change in
our view of how we controlled computers. A shift from telling our com-

puter's fAow to do our chores to telling them w/haz we want them to do.

The ease with which the Macintosh can be used has now opened the

computer world to the many millions of people for whom computers were

forbidding machines.

MacWrite™ and MacPaint™: Two powerful packages for all users

A computer by itself is as useful as an automobile in a country without

roads. In order to be useful, computers need so/fYware, the programs or

sets of instructions that determine the function the computer will perform.
When Macintosh was introduced, it came to the marketplace with two very

powerful software packages—MacWrite and MacPaint.

MacWrite is a tool that lets the user create documents. On the surface,

MacWrite is a word processor—a tool that lets you create, edit, save, and



print word-based documents from letters to book manuscripts. But
MacWrite is far more than a traditional word processor. For example, it
lets you enter text using any of several type designs (called fonts), each of
which can be displayed in different sizes and styles. In this regard,
MacWrite is almost a typesetting system. But even if the multiple font
feature weren't available, MacWrite would still outstrip the capabilities of

many word processing products on the market today.

MacPaint is a tool for graphics creation—from charts and graphs to
freehand sketches. This tool includes many features that take advantage of
the Macintosh high resolution display. In addition, pictures created with

MacPaint can be incorporated into documents created with MacWrite.

MacWrite and MacPaint are two programs that refelect the overall theme
of the Macintosh: They are almost intuitively simple to use. Because of
their ease of use and the high quality of the documentation that
accompanies these programs, this book will focus on applications for

these products, rather than instructing you in their use.

What this book is all about

This book is about applications for MacWrite and MacPaint, applications

that range from the practical to the frivolous—applications from disparate



fields that share a common characteristic: The bulk of the applications in
this book are not just different from those one would expect from word
processing and graphics creation programs on other computers; they are
likely to be virtually /mpossib/e 1o do on other computers. In an era in
which claims of uniqueness are attached to almost every product we buy, it
seemed important to show some examples of applications that are truly

unique and that are not covered in other books or manuals on the

Macintosh.

This and the next chapters provide background information of various
types. The real meat of this book is in Chapters 3 through 5. If you are
already proficient in your use of the Macintosh, you should skip directly to
Chapter 3 and get started on the applications.

If you are still new to the Macintosh, the following brief chapter has some

points you might find useful.



Chapter 2
GENERAL HINTS AND A
FEW SUGGESTIONS

BEFORE YOU START

Setting up your Mac: The importance of good connections

In order to do the projects described in this book, you will need a
Macintosh computer, the Imagewriter printer, and the MacWrite/MacPaint
program disk. The instruction manuals that come with your Macintosh
show you how easy it is 1o hook everything together. In fact, I find the
system so easy to assemble that I can set it up in about 15 seconds (Alan
Alda, eat your heart out). I am going to assume that you already know
how 1o connect everything and that you are familiar with the overall
operation of the Macintosh. If you are nor familiar with the mouse, or
with the use of the computer overall, follow the steps described in your
manuals or take the short course provided on the Guided Tour disk that

came with your system.



Although using the Macintosh is a snap, you can get in a bit of trouble if
you are sloppy. For example, I move my computer back and forth between
home and office. As aresult, I am not always as careful as I might be
when connecting everything. The Macintosh itself doesn't present any
problems since the connectors either snap into place or, in the case of the
mouse, are provided with thumbscrews that make their installation very
easy. The cable that comes with the Imagewriter printer is an exception to
this rule, however. Its connectors come with screws to mount them, and
you need a screwdriver to perform this task. Now, given the mess in my
office, I challenge anyone 1o find a screwdriver there. Besides, I couldn't
find a gorilla in a telephone booth; so I gave up on screwing these

connectors in place and just plugged them in instead.

This worked just fine for quite a while. In fact, I had forgotten that they
weren't secured. But one day I paid for my sloppiness. I was trying to
print a document | had created with MacWrite, and nothing would print
out on paper. Both the Power and Select lights were lit on the printer,
and the Prinat function from MacWrite seemed to be working properly, but
nothing was happening. I looked behind the Macintosh and saw that the
Imagewriter connector had fallen out of its socket. When I plugged it in,
the printer leapt 1o life, spewing out reams of paper with strange
characters on each page. Fortunately, I was able 1o stop this stream of
paper without losing my file. But I had learned a lesson. From then on I
made sure that my printer cable was properly secured at both ends. If I

had followed Apple's instructions, this problem would never have happened.



Success with the Macintosh, as in other parts of life, may depend on good

connections.
The care and feeding of Mac disks
If you have taken a look at the contents of your MacWrite/MacPaint disk,

you may have noticed two interesting numbers:

% File Edit View Special

Write/Paint i cetVF"=—————

=]

S items 349K in disk 51K available o /Pa

& G @

MocY¥rite MacPaint Font Mover

S

System Folder Empty Folder

ol

L'> : Trash




The first number of interest says that there are 349,000 characters of
information already stored on the disk, and the second states that there is
space for 51,000 characters of your own text and picture files. In other
words, there is a lot of room on a Macintosh disk, but most of it is taken up
on the MacWrite/MacPaint disk. If you are going to create your own
pictures and documents, you will need much more space than is left on this
disk. One approach is to make several copies of this disk and, as each fills
up, use a fresh one for new documents. Another choice is 10 make two
copies of the MacWrite/MacPaint disk and to delete MacWrite from one of
them (making it a MacPaint-only disk). You should then delete MacPaint
from the other (making it a MacWrite-only disk). This gives some more
room for your documents and pictures, but the bulk of each disk is still

filled with programs instead of your documents.

The way to maximize the information you can store on your disk is to
initialize your own blank disks and to use them only as repositories of your
own files. This means that to create text or pictures, you will have to
switch between your disk and the MacWrite/MacPaint disk from time to
time, but the result is that you will have almost 400,000 characters of

information storage available on your disk—enough for a /oz of documents

and pictures.
Bven though Macintosh provides you with many useful tools for the care

and maintainance of your e/ectronic deskiop, your physical deskiop is

your responsibility. In your organization of Macintosh disks, you might
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want to create entire disks for each of several major tasks—letters,
graphics, reports, and so on. Blank disks are cheap and don't take up much
room. If you can't find Apple disks in your store, the disks designed for
the Hewlett-Packard computer work just as well. By now there are several
sources for the 3 1/2-inch disks used by Macintosh. Manufacturers who
currently provide these disks include Memorex, BASF, and Sony. A box of
10 disks will last you quite a while and give you room for the creation and

storage of many documents.

When working with the Macintosh, I always use a copy of the
MacWrite/MacPaint disk instead of one of the originals. By keeping the
originals in a safe place, I don't have to worry if I accidentally erase
something from the disk 1 am using, even though the Macintosh makes it

hard for you to throw away a major program accidentally.

The value of a second disk drive

If you are using one disk drive with your Macintosh and have your files on
a disk separate from MacWrite and MacPaint, you will have 1o interchange
disks several times whenever you are reading, saving, or printing a file.
This minor annoyance can be eliminated by the purchase of a second disk
drive. By placing the MacWrite/MacPaint disk in one drive and your
private file disk in the other, all interdisk transactions will take place

without your having to do a thing!
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Recovering from disasters

It doesn't happen often, but disasters can strike anyone, even Mac users.
Of course, disasters always strike when you least expect them. The best
way 1o protect against them is to make sure that you save your work to the
disk frequently. By doing this, you will guarantee that you won't have to
re-creale the entire document or picture; you'll be able simply to reenter

the material you entered since the last time you saved the file.

Unlike most computer systems, the Macintosh lets you know when
something deadly has occurred and even gives you the opportunity to let

the computer try to fix things up:

® File Edit Diew Special

MacPaint Disk

\,.2:.

; Sorry... A serious system error has occurred.
You may choose to restart the system or attempt

to resume the current application.

(Restart) (Resume) 1D=02
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If you see this message on your screen and the cursor still moves when
you move the mouse, you should try the Resume option. Most often, this
works. Once the program is running again, save your document or picture
in a new file, quit whatever program you are using, eject the disk, turn off
the Macintosh, and start everything over again. It is quite likely that you

will be able to recover completely from disasters in this fashion.
Of course, there may be times when this doesn’t work, in which case you
will be happy to know that you have saved your documents and pictures

every 15 minutes or so.

Won't you?
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Chapter 3
THIRTY WAYS TO WORK WITH WORDS:
A COLLECTION OF IDEAS THAT USE

MACWRITE

15



D@E@& 1 l’M GONNA SIT MacWrite

RIGHT DOWN AND WRITE sty

MYSELF A LETTER ot |

Well, here you are with a brand new Macintosh all hooked up and ready to
start, but you need a project. I know one that will probably pay off right
away. If you are like most people, you have had trouble with a magazine
subscription. Phone calls never seem to work, and ordinary letters
somehow lack the expressive strength needed to fix the problem. Asa
result, we sometimes revert to letters that use such forceful prose that we

just make things worse:
Dear Mush-for-brains:

I fail to see why even a functional idiot like yourselfl can
continue to screw things up so royally. Now, instead of two
copies of your magazine arriving every month, I have four
copies coming mstead. If you don't {1 my subscription by the
time I count to ten, I am going to kill myself, and my ghost will
haunt you for the rest of your days.

Interesting? Perhaps—but not very effective.
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The beauty of writing letters with the Macintosh is that you can use
different type styles to express yourself and keep your prose calm and
relevant 1o the problem you are trying to solve. The results are much

better.

To write your letter, you will need to use MacWrite. This program is
started by double-clicking (see your manuals for instructions on double

clicking) the MacWrite icon on the Write/Paint disk.

% File Edit View Special

Write/Paint
5 items 349K in disk

£ & &

MacPaint Font Mover

System Folder Empty Folder
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Once MacWrite is ready 10 use, you can just start typing. Remember that

you need only press the Return key when starting a new paragraph.

® File Edit Search Format Font Style
(—mmm———m—————— ldea |
1260 Feather Way

Sunova Beach, CA 96969

March 19, 1984

Mr. Don deVino
Simperwillow Press
Telmi, WY 67543

Dear Mr. deVino,

This is the fifth letter I have written in an attempt to change my
subscription to the Snake Breeders Journal from four one-year
subscriptions to one four-year subscription. I am enclosing four recent
mailing labels and trust that you will fix this problem immediately.

1 remain confident in your capacity to fix this problem and look forward to i
telling your president how happy I am with your service. I

When you have finished your letter, you will find that there are parts of it
that will benefit from a few highlights. Highlighting text is a fine art. If
you go to extremes, it can make your letter appear cluttered and hide your
message. But on the other hand, a few well-chosen changes to your

typeface can be quite beneficial. For example, you should italicize the fact
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that you have written several times. To do this, you should select the word
you want 1o italicize and then type Command I by pressing the
Command key (the one to the left of the space bar with the cloverleafl on
it) and typing the I key. By using Command B, you can change a selection
to boldface. The normal type style can be ch'osen by pressing Command

P. After highlighting a few words, your screen might look like this.

& File Edit Search Format Font Style

Idea |

1260 Feather Way
Sunova Beach, CA 96969

March 19, 1984

Mr. Don deVino it
Simperwillow Press
Telmi, WY 67543 i

Dear Mr. deVino,

This is the fif1h letter 1 have written in an attempt to change my
subscription to the Sanate Breeders Journal from four one-year
subscriptions to i four-year subscription. 1 am enclosing four recent
mailing labels and trust that you will fix this problem immediately.

I remain confident in your capacity to fix this problem and look forward to
telling your president how happy 1 am with your service.
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Next, we need to make sure that certain words can be read, so we will
make them bigger. Select an appropriate word to enlarge and pull down
the Style menu by moving the cursor to Style and pressing the mouse
button. While holding the mouse button down, move 10 the type size you

want and release the button to make the change.

Notice that type size is measured in posnts The last time I checked, there
were 72 points per inch. Normally, you will use lZ—poi'm type. This is the
closest size 1o the one you normally use on a typewriter. It i1s useful to be

able to change type size whenever you want, however.

& File Edit Search Format Font p _
ED—-———-———m Idea| Plain Text *P %‘
1260 Feather Way vBold %8 >
Sunova Beach, CA 96969 /talic |
Underline 3U
March 19, 1984 Ouline %0

Shadom 38s

Mr. Don deVino

Simperwillow Press P Polnt
Telmi, WY 67543 viz Peint
14) Polng

Dear Mr. deVino,
24 Polnt

This is the fifth letter 1 have written in an attempt to change my

subscription to the Spake Breeders Jourmal from four one-year
subscriptions to four-year subscription. 1 am enclosing four recent
mailing labels and trust that you will {ix this problem immediately.

1 remain confident in your capacity to {ix this problem and look forward to
telling your president how happy 1 am with your service.
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Finally, we might like 1o let our reader know that we are more than mildly
disturbed. There is nothing quite like Old English type 1o setl the proper
tone. Again, select the proper word, pull down the Fontl menu, and select

the London font to complete the job.

Style

NewYork EV———uo— ]
| o

MT, Dol GeVino ‘Geneva
Simperwillow Press Toronto
Telmi, WY 67543 Monaco
Chicago
Dear Mr. deVino, Uenice
This is the s77tf1etter 1 have wrif Athens to change my
subscription to the Swake Breed San francisco}, four one-year

subscriptions to OM € four-year subscription. 1 am enclosing four recent

mailing labels and trust that you will fix this problem [QUEUENUKIEd]E

I remain confident in your capacity to [ixX this problem and look forward to
telling your president how happy I am with your service.

Yours for happy snake breeding,

Elihu Morrison XXIII Eﬂ

33933595300 25395

Will this letter do the job? My experience is that letters created in this
fashion are quite successful. Just remember that, all evidence to the
contrary, you are dealing with another human being who probably wants
to help you. Adjusting your fonts and styles lets you be forceful while

remaining civil.
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DELA 2 THE RANSOM NOTE  Macwite

B

Style

Font. -

Did you say you were a poor struggling college student who had to wash
dishes at the local hash house to make enough money to buy your Mac?
Did you say that you had to forgo any semblance of social life because you
spent your last dime on a second disk drive and your blue jeans are so
tattered they were rejected by the Salvation Army? Is that what's
bothering you, bucko? Well, help is at hand. Now you can use your new
computational wonder to enlist the support of your folks to pick up the tab

for your computer.

I'm sure you already tried to get them to help pay for your Mac, but they
responded with the same tired excuses—wanting to eat, paying the mort-
gage, helping your Aunt Elsie escape from a Brazilian nudist colony—but
you really need the bucks, and they haven't come through. The trick to

winning them over may be to try the cute surprise: a ransom note, perhaps.
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Now, everybody knows that a ransom note isn't printed with pretty fonts.
Nosiree Bob! A true ransom note looks like the letters have been cut out of
the newspaper. The first version of the MacWrite/Mac Paint disk came
with a font (San Francisco) tailor-made for just such emergencies. If you
don't have this font on your disk, you have a new version of the sofiware,
and you should check with your dealer to see if he has an old one lying

around that you can use. It's worth it for emergencies like this.

Bring up MacWrite and type a letter. Mix upper- and lowercase letters for

the authentic look.

% File Edit Search Format Font Style

ldea

{ dEar MR ANd mRs wOrthinGTon PennywORT

Your CHILD is BEing heLd CAPTIVE by a wliD COmpUTER and will bE
ReLEaSEd wHEN you Send your child a CHECK large eNough tO Cover the
eNClosED iNvoiCes

p.S. SOMe hoME mADe COOkies WOuld BE aPPreciated too! |
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Now that you have your basic letter written, select all of the text. The way
to do this is to move the cursor to the beginning of the document, press the
mouse button, and pull the mouse to the bottom of the screen. All the text
in the window will be selected, and new text will scroll into view from the
bottom and be automatically selected as it appears. When all the text is
selected, pull down the Font menu and select San Francisco. Release the

mouse button, and all your text will be changed to the new characters.

% Ffile Edit Search Format TN style
New York

Geneva
Toronto
Monaco
Chicago
Uenice

London
Yogr [HILD 1§ BEtng held [RPYIV) gepane

RelEazEd wHEN Yoy Send Yo r W3 TTIET I
eN[]odED INrol[el.

== =] |

1ER and wi]] BE
e eNoggh {0 [creF the

pS Simg hoME mRDg [Ilkiel Wigld BE aPPreciated 1 ool
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Next, increase the type size 10 24 points, for the final touch, and your
ransom note is ready to print and send. If you don't have San Francisco
on your disk, you can still create the same effect by changing each letter to
a different font by hand. Alternatively, you could send the letter using the
Cairo font (found on the new versions of MacWrite/Mac Paint). While
your folks won't be able to read the letter, they may at least think it looks

pretty:

® File Edit Search Format Font Style

s dand anda 131 Lad o b 14 RS VPV SNPYNNS SNPIND Joey SUOF TIUTIY WIPIND SOOPUR Soor SIS SV O JRUIY THPU B

[ efr, B d=s Oby, =, l0=0mE0d
| tedQE4e s

| Ok, ST g TR 30 Owbe FllE=tH

| o 7 fmnpy FoFhAfR /s A oo ot

| Bm b=t Sl BFOF oeQe BOF, B o 7
| BB 3,0 v 0o l#2 g90nw, D=
| = B onfies & ~0P P =

| P a@..w DO 0lfie FSSrd s
| B oe O5 /), a8qllne LOOF

For your future health and the sanity of your folks, make sure they know

this is only a joke. If they don't send the money, they may at least

appreciate your creativity.

26



Io/ZA 3 FORM LETTERS Machis |

Search

Let's face 1t, you hate to get them yourself, but sometimes there is no
replacement for the form letter. Personalized form letters can take away
some of the "junk mail” aspects of this medium, as long as it isn't carried
too far. Unfortunately, some form letter writers give themselves away by

making their letters ro¢ personalized:

Yes, Mr. and Mrs. Bjiercan, you 100 can own some of the finest
land in Florida. Imagine your friends surprise when they go on
a National Geographic tour of the swamps and see the cozy Mr.
and Mrs. Bjiercan cotlage floating among the mangroves as your
own herd of alligators keeps the Mr. and Mrs. Bjiercan cottage
safe from prowlers . ..

Well, you get the point. However, as [ said, form leiters have their place,

and your Macintosh can help your write them.
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The first step in creating a form letter is to compose the she//—a copy of
the letter in which each place to be customized has been marked with a
code. Choose any lext you want for this code, as long as it isn't used else-
where in the letter. For example, you might want to use Fl everywhere
the first name is to appear, L1 for the last name, Al, A2, A3 for address
lines, and so on. Once you have created this letter with MacWrite, save it
on your disk. Next, place your list of names and addresses in front of you,
ready to use. Suppose you want to send your first form letter to Penelope
Stonethorpe, 1776 Comfort Station Way, Asparagus, Wisconsin 77007. To
do this, load your form letter, pull down the Search menu, and select the

Change option. You will be presented with the following message.

% File Edit Search Format Font Style

'*n. Find what |F1 | .174

&l G Change to |Penelope

g:siﬂ (Find Nexnt) ({tange. then find) [(Chenge] [ Change AIN)

@® Whole Word O Partial Word

MarcrT9-T90T

Fl L1
Al
A2
A3

Dear F|,

We have been checking our files, F1, and we found that you were
accidentally shipped 100 copies of The Zea of Bowling instead of the —
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As you can see, we entered F1 in the box marked Find what and
Penelope in the box marked Change to. To make all the changes, select
the Change All option on the Change menu. As soon as you select Lhis
option, you will be presented with another messgage that gives you one
more chance 10 change your mind, since you cannot “undo” the result of a

Change All command.

® File Edit Search Format Font Style

Change
'4‘;. Find what |F1 .174
&l ¢ Change to |[Penelope
9894

Fast | (Find Newt] [Change. then find ] (Change] (Change ANl )
@ Whole Word O Partial Word

IWARNING! *Change RII* is NOT Undo-able!

M

F1 e '
X [ Go Anead |
Al
A

Dear F 1,

We have been checking our files, F 1, and we found that you were
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Repeat this process for the remaining items in the address. Once you are

done, you can print this letter.

To start the next letter, you can replace Penelope with the next first
name, and so on, until you have printed all your letters. While this process
is not completely automatic, it saves a lot of time compared to that spent

typing each letter from scratch.
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IDEA 4 LETTERS MacWrite

TO EUROPE Apple

& oD

You have no doubt noticed that other countries use alphabets with special
marks on some of the letters. Most typewriters and word processors don't
have the capability of handling these special letters, and we are sometimes

forced to go over a letter by hand to make it “look right.”

Fortunately, the Macintosh is an international machine, and MacWrite
contains a full set of optional characters (accessed with the Option key)
that let you spell your pen pal's name correctly. To see the characters you
have available 1o you, pull down the Apple menu (the one shown by the
little apple) and select the Key Caps item. Your screen will show the

arrangement of keys on your keyboard.
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When you press the Option key, the layout will change to show a set of

special characters that can be obtained with the help of the Option key.

As you can see, the Option key gives you access 1o many more characters.
When you are done looking at these keyboard layouts, close the Key Caps

window by clicking the mouse in the little box in the upper left corner.
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Though the Option keyboard shows the range of choices available to you,
some fonts may offer more of these choices than others. Generally, you
will find that commonly used fonts such as New York and Geneva will

have ail the special characters you need.

As it turns out, some of the Option characters are typed in conjunction

with normal letters, and others stand by themselves.

For example, suppose you wanted 1o write a letter 1o Francoise André and
her brother Juan jose Brederbiast. (There was a third brother who
changed his name to juan Cafion Miiller and left the family home at an
early age and was pursued for much of his life without ever being found.
He became known as the Juan who got away.) To type this letter, you
would just type normaily until you got to the ¢ in Frangoise. To make this

character, you would hold down the Option key and press the ¢ key.
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Placing the accent on the e in André is a little trickier. After typing ther,
you hold down the Option key and press the e key. Nothing will happen
until you type another letter. If you now type e, an accented é will appear

on the screen.

20 March 1984

My Dear Frangoise André |
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Other types of marks above letters (such as the tilde and the circumflex)
are created in the same way: Type the abpropriate Option key first,
then type the letter 1o be accented. Other special characters are created by

just typing the appropriate Option key (2.2, Angstrom).

& File Edit Search Format Font Style

.!f..x...;...1.......1.......1.?;...1.......1...‘.,.1.... 13 i dstin 14.__.1.... T 'A‘ N L T
@ == EEE

20 August 1984

My Dear Frangoise André,

By now you have no doubt heard the tragic news about your brother jJuan
--not Juan one, but Juan two. (I would be mortified at the thought that I
would confuse one Juan with the other, and so I trust you know that I was
thinking of your recalcitrant Juan Muller )

As he was cleverly disguised as Juan one, | accidentally helped Juan two
escape with the help of Per Angstrom.

Please convey my regards to your brother. I am sorry if 1 have caused any
grief, but it seems you always hurt the Juan you love | I
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As you tinker with the characters made available through the use of the
Option key, you will find that your foreign friends might write more often.
And if you have a friend in Egypt, you might want to select the Cairo
typeface:

% File Edit Search Format Font Style

. — po—
{ !*l A 121 Aeand 13 i P odoa. 14 doa s 15 A AA LA 16 Alll?l
1= - - IEI El == -

| JEoFwd Peb)

giml, /8 OOy . wlfrm, i
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Now, if only your pen pals would respond in English!
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1DEA D LETTERHEADS waowic | N

—IF YOU CAN’T HAVE

THE FONT YOU LOVE...

No self -respecting business person would send out a letter typed on a
naked sheet of paper. That lacks class and makes it look like you run a
shoestring outfit. Fortunately, as long as you have your Macintosh, you can
dispel the myth of poverty by sending letters written on wonderful
letterheads of your own design. In fact, you can create new letterheads

every week if you want.
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As any highly paid public relations expert will tell you, letterhead design
(as part of your corporate "image”) is a fine art (in other words, it costs
beavcoup bucks). Well, using the various fonts and styles you have on
the Macintosh, you can create interesting letterhead designs without

spending much money at all.

You must first think of a name for your company. Once you have done
that, you should think about the name=is it forceful, techy, soft, sincere,
flamboyant, and so on. Once you have made this decision, you are ready to
start picking a typeface for your letterhead. Let’s suppose that you are in
the wood paneling business and you want 1o make your own letterhead.

The best place to start is with the name of your company.

Wavne Scott
Paneling Company

Hayne Scott
M Paneiing Compary
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% File Edit Search Format Ffont Style
SHE=E===——————— l|dea )

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

f

Notice that the name was typed in 24-point characters and that the
address was left in the normal 12-point type. It is often a good idea to

draw attention 10 your company name by making it fairly large.
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Of course, you may nol want this particular typeface for your letierhead.
The easiest way to experiment with different typefaces is to0 make several

copies of the leiterhead text and to change each of them to a different font.

Making copies of text is fairly easy. First, you should select the text you

want to copy and then select the Copy option from the Edit menu.

Search Format Font Style
tani Undg &2 Idea 5

cut M aneling Company
Copy #C _ Forest, I[N 47676
Paste &8

Show Clipboard

40



Next, move the cursor to the end of the text and select the Paste option
from the Edit menu. Each time you select Paste (or, alternatively, type

Command V), another copy of the text will be appended to your docu-

ment.
% File Search Format Font Style

=] Undo Paste $Z &= |dea 5
wWay| tm sxcpneling Company
12 Plywq (8py 5l Forest, IN 47678
Way ........................................................... neling Company
12 Plywood Drive, orest, IN 47678
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Once you have created a few copies of the text, change the first line of each
sample to a different font. Some fonts will appeal 10 you right away, and
others will look horrible. For our example, [ think that the starting font

(New York) looks just fine.

& File Edit Search Format Font Style
I————————————— Idea 5

IHIII

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

wWayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 476738

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

IWayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

12 Plywood Drive Sherwood Forest IN 47678
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Next, you can make some copies of the letterhead text with this font and
iry some of the Style options: Plain, Bold, Outline, Shadow—each of
these lends a different character 10 the letterhead. I think I prefer the

Shadow style myseif.

% File Edit Search Formal Font Style
D dea s oieee————————

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

Wayne Scott Paneling Company

12 Plywood Drive, Sherwood Forest, IN 47678

Wayne Scott Pansling Company

12 Plywood Drive, Sherwood Forest, IN 47678

A\3239533804313 838
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€ File Edit Search Format Font Styie
&[] Idea 5
)

Wayne Scott Pancling Company

12 Plywood Drive, Sherwood Forest, IN 47678

March 20, 1984

Walter Walcarphet

Flooring Services Corp.

12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate the birthplace of
Attila the Hun. I think we really spiffed the place up a bit by ripping out
that sleazy old wood and replacing it with our new WonderBoard™ I %

40 0 * aVs 2 - o D DA 20 ®, QT ) DG Qo 410
2o LA I AT I A2 5L AN I A AILE 433333353 8085300 53 S3ANIINE9R5 83N 1300331 3333293333395 3233030832 23 5

After picking out the font and style for the first line of the letterhead, you
can then repeat the process for the address line. Assuming you print your
letters on high-quality paper, your letterheads can reflect the high quality

of your business.
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=L © FAREWELL, actite | &
SWEET PRINTS

If you have been reading straight through to this point you will notice that
I got so carried away with the creation of letiers that I forgot 1o tell you
how 1o print them! Of course, as you know from your Macintosh manuals,
your printer is easy 1o use, and you probably have it under control at this
point. Still, I seem always 1o be finding out new things about the printer,

so I thought a few words on this topic might be appropriate.

When you are printing out letters and such, all you have to do is select
Print from the File menu. Once you make this selection, you will see the

following image on the screen.
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MEdit Search Format Font Style

Idea 6

Quality: O High
Page Range: @ Al
Copies: 1
Paper Feed:

® Continuous O Cut Sheet 3

@ Standard O Draft
O From: To:

that sleazy old

Walter Walcarphet
Flooring Services Corp.
12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate the birthplace of
Attila the Hun. I think we really spiffed the place up a bit by ripping out
wood and replacing it with our n

- a¥s -
2

ew WonderBoard™

D AT

The three options on the top line relate to print quality. High gives the

highest-quality print but takes a long time to generate a document (first

sample letter). Standard is great for drafts but is a tad on the light side

(second sample letter). Draft doesn't even try to be pretty—just fast (third
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Wayne Scott Pansling Company

12 Plywood Drive, Sherwood Forest, IN 47678
March 20, 1984

Walter Walcarphet

Flooring Services Corp.

12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate the birthplace of
Attila the Hun. I think we really spiffed the place up a bit by ripping out
that sleazy old wood and replacing it with our new WonderBoard™
wainscot paneling. That, plus your plush MagicPile™ carpet really did the
trick.

Now, for our nexz job, I was thinking of bidding on the contract to panel
the Lincoln Memorial. Our limed oak would look good against the marble,
and your custom carpeting with the prints of Lincoin head pennies would
be appropriate. I think people would just love it, dont you?

Yours in rebuilding the world,

Wayne Scott
(remember, its not wainscot paneling if it isn't from Wayne Scott!)
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Wayne Scott Pansling Company

12 Plywood Drive, Sherwood Farest, IN 47678
March 20, 1984

Walter Walcarphet

Flooring Services Corp.

12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate the birthplace of
Attila the Hun. I think we really spiffed the place up a bit by ripping out
that sleazy old wood and replacing it with our new WonderBoard™
wainscot paneling. That, plus your plush MagicPile™ carpet really did the
trick.

Now, for our srext job, 1 was thinking of bidding on the contract to panel
the Lincoln Memorial. Our limed oak would look good against the mathle,
and your custorn carpeting with the prints of Lincoln head pennies would
be appropriate. 1 think people would just lowe it, don't you?

Yours in rebuilding the world,

Wayne Scott
(remetaber, its not wainscot paneling if it.isn't from Wayne Scott!)



Wavrne Scott FPamneling Company
12 Plywood Drive, Sherwood Forest, IN 47478

March 20, 1984

Walter Walcarphet

Flooring Servicee Corp.

12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate  the birthplace of
Attila the Hun. I think we really spiffed the place up a bit by ripping out
that cleazy old woed and replacing itwith our new WonderBoard

wainscot  paneling. That, plus your plush MagicPile carpet reaily did the
trick.

Now, for our next  job, I was thinking of bidding on the contract to panel
the Lincoln Memorial. Qur limed oak would look good against the marble,
and your custom carpeting with the prints of Lincoln head pennies would
be appropriate. I think people would Jjust love it,don’t you?

Yours in rebuilding the world,

Wayne Scott
(remember ite not wainscot paneling ifitisn’t from  Wayne Scott?)
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sample letter). Draft quality is OK when you need to proofread a long
document, but it doesn't let you know which words are in italics, and

symbols tend to disappear.

For printing letters (especially with your built-in letterhead), you will
always pick the High quality option and then click your mouse in the box
marked OK. If you want to print more than one copy of your document,
just select the 1 in the Copies box and replace it with the number of copies
you want to print. When making multiple copies, especially of long
documents, your computer will be tied up for a while as each copy is
printed. Also, you will wear out your ribbon if you print lots of copies.

The Mac is terrific for creating original documents, but it isn’t the world's

best copying machine.

Quality: O High @ standard O Draft (oK )
Page Range: @ Al () From: || To:

Copies: 1 .
Paper Feed: @ Continuous () Cut Sheet [ cancel )
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The Page Range portion of the Print function is worth explaining.

Normally you will print the entire document. But sometimes you just need

to print a page or two. Suppose you have just finished printing a lengthy

tome on charitable contributions to aid the Venetian Blind and you

discovered that you misspelled e/eemaosynary (go ahead, look it up) on

page 13. Rather than reprint the entire document, you can simply reprint

page 13. To do this, enter 13 in the From box and 13 in the To box:

Paper Feed: @ Continuous ) Cul Sheet

Quality: {2 High @ Standard () Draft
Page Range: (Al @ From: |13 | To: |13
Copies: 1

o]

[ Cancel ]

Now when you select OK, your printer will print only page 13.

One other subtlety of this feature needs explaining. The numbers we put

in the From and To boxes tell us the page range of the document we have

in memory at that time. In other words, in our example, we will print the

thirteenth page of the document. This page may or may not be

numbered (we discuss that later), and its number may or may not be 13.
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Your Imagewriter printer can handle both cut-sheet or continuous (fan-
fold) paper. The bottom line of the Print screen lets you select which you

are using.

You will find that your most recent printer settings will be remembered by
MacWrite (except for the number of copies and page range), so you usually

don’t have to make changes to this screen.

Paper: QO US Letter (O R4 lLetter [ oK l
QO US Legal (O International Fanfold

Orientation: (O Tall OTall Adjusted O Wide [ Cancel |

Now you may be a lawyer or someone who got a good deal on some funny-
sized paper. If this is the case, you will also want to let your printer know
that you aren't printing on standard 8 1/2-by-11-inch paper. Changes of
this sort are also handled through the File menu using the Page Setup
function. Once this function is selected, you will see on the following image

on the screen.
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MEdn search Format Font Style

Idea 6

Paper: @ US Letter (A4 Letter
O US Legal O International Fanfold

Orientation: @®Tall  OTall Adjusted O Wide

e

March 20, 1984

Walter Walcarphet

Flooring Services Corp.

12 East Snavely Lane
Brookside Heights, PA 25463

Dear Walter,

It was a great pleasure working with you to redecorate the birthplace of
{ Attila the Hun. I think we really spiffed the place up a bit by ripping out
that sleazy old wood and replacing it with our new WonderBoard™

LT 4 1) - a1 aVe -
g i TR

The normal setting is for traditional 8 1/2-by-11-inch paper (US Letter).
By clicking your mouse in the right circle or word, you can change the
paper size seiting. Once you have approved of the change (by clicking your
mouse in the OK box), your document will be reformatted on the screen to

let you see what it will look like when printed.
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The orientation line can be changed 10 produce some special features, but
we will discuss these later on. For now, you wiil probably want to leave

the orientation selection at Tall.
Changes to Page Setup are remembered automatically. If your documents

are being printed in the "wrong” size, you probably forgot to change the

Page Setup settings.
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o257 PLACE SETTINGS  Meowie

Font
Style

Print

It finally happened. You have decided to get married, and your
prospective in-laws are coming over for dinner. Well, obviously, you want
them to think you are classy, so what better way to convey this image than

by throwing a formal dinner party?

To be really chic, you will need to borrow some good wine bottles to hold
your jug wine, and you may want 10 have someone help you throw out all
your old Chicken Licken wrappers. Even aflter you have prepared your
menu, scraped the candle wax off the floor, caught vour trout, and shot
your pheasant, you still have.some golden opportunities to impress your

guests as they have never been impressed before.
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You can use your Macintosh to make custom place markers and custom

menus. Woweel

Making place markers is a snap. All you have 10 do is select the 24-point
London font and type the names, leaving several Returns for vertical

space between them.

flr. Byuton Tynn

Mrs. Bynton Tynn

Miss Muflin Tyun

Me. Jock SHnett

After printing these place markers, cut them out (use blunt scissors so you

don't hurt yourself) and fold them in two so they stand up.
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Next, for the extra touch, create a personalized menu for each person.
Choose your font and size carefully for the maximum effect. I prefer
14-point Venice myself, but feel free to choose your own favorite.

When your menu is complete, print each personalized copy on high-quality
paper and make sure your guests know they can take it home 10 giue in

their scrapbook.

I guarantee that yours will be a meal they’ll never forget!

Menu for Miss Muffin Tynn
Appetizer

Créme cheese flambé on saltines
Liver paté on crackers de Ritz
Soup

Créme de mushroom i la Campbell
Entrée

Peanut paté sandwich with
Romaine lettuce en Croissant
Dessert

Les Twinkies au Jeli-O
Beverages

Vin maison: Thunderbird, 1984
Milk glacé au chocolat

Café

Cognac de la Vallée de Napa
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Menu for Miss Muffin Tynn

Appetizer
Creme cheese flambe on saltines
Liver paté on crackers de Ritz

Soup
Creme de mushroom a la Campbell

Entree
Peanut piate sandwich with
Romaine [ettuce en Croissant

Dessert
Les Twinkies au Jell—0

Beverages
PVin maison: Thunderbird, 1984
Milk glace au chocolat
Cafe
Cognac de [a Vallee de Napa

9
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D=4 8 WRITING e | N
POETRY Sty

Font

The message conveyed by a poem can lie as much in its appearance on the
page as it can in its words. MacWrite is a wonderful tool for poets, simply
because it lets you experiment with the placement of words on the page, as
well as with the typeface you are using. To show how you can showcase

your own poetry to its best advantage, we will use the second stanza of a

poem by e. e. cummings.

somewhere i have never travelled,gladly beyond

any experience,your eyes have their silence:

in your most frail gesture are things which enclose me,
or which i cannot touch because they are 100 near

your slightest look easily will unclose me

though i have closed myself as fingers,

you open always petal by petal myself as Spring opens
(touching skilfully, mysteriously)her first rose

—-—¢. €. CUmmings
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® File Edit Search Format Font Style
N e =F——7—+————
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{1 your slightest look

easily will unclose me
though i have

closed

myself as fingers,
you open

always

petal by petal

myself as Spring
opens

(touching skilfully,
mysteriously)

her Iirst rose

»_":.

After you have read the poem, I would like to direct your attention to the
ruler at the top of the screen. MacWrite uses rulers to set the format of
your documents. When you first start to create a MacWrite document, the
ruler is set up for the creation of single-spaced text with what is called
‘ragged right” justification. All ragged right means is that the first letter of
each line lines up with the first letters of the other lines and the last letter
of each line ends up wherever you leave it. This makes the right edge of
the page of text ragged. If you look at the row of four bozes between

inches 5 and 7, you will see that the first box is black, showing that it has

been selected.
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These four boxes are used to select any of four alignment options: ragged
right, centered, ragged left, and full justified. The next two illustrations

show the appearance of our poem in ragged lefi and centered text.

® File Edit Search Format Ffont Style
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(@ ==
: your slightest 100k
easily will unclose me
though i have

closed

myself as fingers,
you open

always

petal by petal

myself as Spring
opens

(touching skilfully,
mysteriously)

her first rose

e
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Because we used a Return at the end of each line in the poem, we cannot

see the result of full justification, but we will explore that later on.

® File Edit Search Format Fontl Style
=——————————— I|dea 8

gl‘*lhllldlzalalallljnla,l ..lq.lk.,].,.l.ls.‘ Aalalﬁl i Al;l‘?

your shightest look
easily will unclose me
though 1 have
closed
mysell as fingers,
you open
always
petal by petal
mysell as Spring
opens
(touching skilfully,
mysteriously)
her first rose

I find the centered text to be particularly attractive for this poem, but |
would rather use another typeface. Here is the cummings quote again,

printed in 18-point Venice.
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your slightest look
easily will unclose me
though i have
closed
myself as fingers,
you open
always
petal by petal
myself as Spring
opens
(touching skilfully,
mysteriously)
her first rose
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Here is the entire poem, printed exactly as e. e. cummings wrote it:

T i R R e R S e R e R R R R R R R R R R R N R S R N R R R N R R R R R R R R R R R

somewhere i have never travelled, gladly beyond

any experience,your eyes have their silence:

in your most frail gesture are things which enclose me,
or which i cannot touch because they are too near

your slightest look easily will unclose me

though i have closed myself as fingers,

you open always petal by petal myself as Spring opens
(touching skilfully, mysteriously)her first rose

or if your wish to be close to me,i and

my life shut very beautifully,suddenly,

as when the heart of this flower imagines
the snow carefully everywhere descending;

nothing which we are to perceive in this world equals
the power of your intense fragility:-whose texture
compels me with the colour of its countries,
rendering death and forever with each breathing

(i do not know what it is about you that closes
and opens;only something in me understands
the voice of your eyes is deeper than all roses)
nobody,not even the rainhas such small hands

R T 2 223 2 2 3 g AT
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pEA 9 THE WEDDING MecWite

INVITATION

Your poems have cast their spell, and the time has come to tie the knol.
What with the expenses associated with marriage being so high, you should
be expected 10 save some money somewhere. But inexpensive needn’t be
tacky. You can use your Macintosh to create stunning wedding invitations.
As with the poelry example, centered text with the Venice font is quite

attractive.
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Dr. and Mrs. Peyton Saints
are pleased to finally announce
the marriage of their last daughter
Wendy Saints
to
Dr. Ron D. Vous
at

The First Church of What's Happening Now
1237 Elm
Expandable, Wisconsin
on
April 15, 1984, 3 PM

R.S.V.P.
Send Money

To make your invitations look their best, print them out using 24-point
type and then have your printer reduce the original by 50 percent when
printing it. This will have the effect of diminishing the “jaggies” on your

characters.
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oA 10 THE AWARD aoWrite

There is always a special occasion that deserves celebration. Perhaps you
survived an entire Christmas party without being yelled at by your Aunt
Edna, or perhaps your secretary has finally, after three years, learned to
spell your name correctly. ['m sure that on any given day, you can single
out at least one person who deserves recognition for some stellar

accomplishment.

With so much to celebrate, you obviously don't want to have to spend
money on a gift, so what better gift to give than a personalized certificate
of merit, suitable for framing? And just how is this splendiferous docu-

ment to be created, you ask? On the Mac, of course.

The best approach is to type in the contents of the award, proofread it for

errors, and then change the typeface and size as appropriate. If you are in

the habit of giving out a lot of awards, you may want to keep much of your

award the same and just change the personal material.

10

Font

Style
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Remember, when composing your text, lesser accomplishments deserve

even more flowery praise.

To AL X who shatl see these presents, BREETINGS.

Be it known that on the 24th of March, in the year of Our Lord
1984, our noble and trusted errand person,

Mr. Stan Ding

Did in fact, and in the presence of several witnesses,

walk and chew gum at the same time.
In honor of this momentous occasion, through the powers

vested in me, | hereby present and proclaim as the only true and
official record of this feat,

this atoard.

Be it here enacted, by my signature below, that this award is
conveyed to the recipient in lieu of his being dismissed for goofing
off on company time.

His royal and noble scribe,

Nick Alodean
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=5 41 HEAD OVER oo | N
HEELS OVER HEADERS ot

AND FOOTERS Style

Font

So far, all our documents have been about one page long. If you are
interested in creating longer documents {and who isn't?), you probably
would like a way to number your pages. Furthermore, you would probably
like the option of numbering your pages at the top or at the bottom, and, if
you are a legal eagle, you would like a place on each page for someone to
witness that he or she read the contents or to notify the reader that the
contents are confidential, or the like. In other words, you need to learn

how to create page headers and footers.

Headers and footers are valuable even without any text on them because
they let you set the vertical margins for the page. This is important when
you don't want text to appear too close 1o the top of a page or too near the
bottom. For example, creative use of headers and footers (and double
spacing) can let you turn that |5-page report into a 20-page tome—far

more impressive—without adding a single line of text.
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But enough of the practical rationale. How do we do it?

If you pull down the For mat menu, you will see an entry called Show

Header. Selecting this option will cause a header window to be shown on
the screen.

% File Edit Search Format Fonl Style

| Header |
N @
l'*lalalilznlalslnl:nlnlnlAlqllalnlaisniAAglalbalglAlAI
@ == =) E=EE

=]

This window looks like an ordinary text window, except that above the

ruler there are three special marks. The mark to the left (the one with the

# sign in it) stands for page number, the center mark with the numbers in
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it is a date marker, and the clock face 1o the right is a time-of -day marker.
These markers can be used in conjunction with text to set up your header

for your document.

For example, let's suppose you are an inventor and you want to create an
invention disclosure for m using your Macintosh. Information that you
might want on each page of your invention disclosure would include the
date and time of creation, page numbers, and space for you to sign each
page and have it witnessed. We will put the signing and witnessing

information in the footer and the rest of the information in the header.

First, we will enter the texi associated with the header just as you would in
the main text window. You can use the ruler to adjust margins, spacing,

centering, and so on, just as you would normally.

® File Edit Search Format Font Styie

e~
O] @ (]
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|

| Invention Disclosure Confidential!
)| Page
Date Time
E
R
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Next, we will pull the page number icon down from the ruler to reside next
to the word page and bring the date and time-of-day markers down to
their respective positions in the same manner. To move a marker, just
point at it with the mouse, hold the mouse button down, and drag the
marker to its resting place. You may want to add a few Returns to give
some space between the bottom of the header and the first line of text on

the page.

& File Edit Search Format Font Style

Header |
l'*lalllnlzalllslal3llalll&140lllllalstltAllllﬁtl&i&lal
= == B8 = = =
Invention Disclosure Confidential!
; Page
Date @ Time
' =
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Now that the header is finished, click the mouse bution in the normal text
window to make the header appear in its proper place on the screen. As
you will see, the header will be shown in its proper position above the text

window, with all the numbers filled in automatically!

Next, pick the Show Footer option from the Format menu. Once again
you are shown a special text window complete with its own ruler and set of
special symbols. For our footer, we will provide room for two signatures.
First, enter a few Returns to provide space below the last line of text on
the page, then enter the text you would like to have appear at the bottom

of each page.

% File Edit Search Format Font Style

—— looter

@ ]
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Witnessed and understood: Submitted by:

Dateg& — w10 Date:

=l
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Once you have completed this task, click your mouse in the normal text

window 1o make the footer appear in its normal place.

Headers and footers are quite valuable additions to your documents. But
sometimes you don't want to have them appear on the first page of a
document. In this case you can select Title Page from the Format menu

1o supress the printing of header and footer text on this page.

& File Edit Search Format Font Style

idea 11
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Improved Method for Transmuting

Lead into Gold

Introduction: Previous methods of transmuting lead into gold have
relied on certain magical techniques that have eluded reproduction 1n a

sufficiently wide scale to allow the process to be commercially viable
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The easiest way | have found to edit headers and footers is to select Hide
Header and then Show Header from the Format menu to make the

header window visible.

Through the creation of several standard sets of headers and footers, you
can create a series of blank forms to use with your business. Each of these
forms should be kept in a separate file to simplify the creation of standard

documents.

& File Edit Search RIUIULLIM Font Style

e |nsert Ruler
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Disptay Footers
Set Page ¥...

insert Page Break
Title Page

Transmuting
old

Improved

Introduction: Previous methods of transmuting lead 1nto gold have

relied on certain magical techniques that have eluded reproduction 1n a

aaan

sufficiently wide scale to allow the process to be commercially viable
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A document with headers and footers appears on the next page.
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Invention Disclosure Confidential!
Page 1
Date August 2, 1984 Time 12:40 PM

Improved Method for Transmuting
Lead into Gold

Introduction: Previous methods of transmuting lead into gold have
relied on certain magical techniques that have eluded reproduction in a

sufficiently wide scale to allow the process to be commercially viable.

The present technique relies on magical techniques generally well known
in the state of the art, but is unique in that the transmutation apparatus is
provided with several of the beam deflector circuits previously used in the
transfor mation of sow's ears into silk (see US 3,456,789). The extraction of
the appropriate essential energy needed to effect the transmutation is
performed in the accepter chamber denoted by areas | through 7 in Figure
1. The lead is placed on.a conveyor (14) and conveyed by normal
conveyance means that include, but are not limited to, the movement of

said lead through the motion of a webbed belt under the motive power of

Witnessed and understood: Submitted by:

Date.___ Date:
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Style

Getting fed up with your old job? Time to dust off the old résumé and
make a few well-placed phone calls. The only problem is that there are a
lot of people in the market for a new job, and you need to find one way to
stand out from the crowd. Now I'm no expert at getting jobs, but a lot of

résumés cross my desk, and I know which ones I like to read.
To start with, you should write your résumé with the intention of capturing

your reader’s attention in 15 seconds. If you haven't captured his or her

interest in that amount of time, you may move to the bottom of the pile.
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Your Macintosh and a good job-finding book (such as ¥What Cofor /s Four
Parachute?) should put you well on the road to getling a new job. As
with other letters, your résumé should make tasteful use of fonts and avoid
being garish. Also, your text should be upbeat and stress your actsvities,
not your snlfentions In other words, use action words wherever possible.
Words like direcied, developed, sold, and managed are good words to
use, while words like assisted, coniribuvted, p/lanned, and belped

should be avoided whenever possible.

You want to convey a sense of energy and willingness to tackle a job that
will make the personnel director call you in for an interview immediately.
Your cover letter can help your résumé, but it shouldn't be a replacement
for it. The things to stress in your cover letter are your specific job skills
that are relevant to the company to which you are applying. Also, you
should suggest a specific job interview date and follow up with a phone call

once you are sure your résumé has been received.

Also, if you are going to title your document Résumé, don't be tacky and

call it "'Resume” instead!

As with poetry, page layout can be important. You should get your main
attributes and accomplishments on the first sheet of paper and save the

boilerplate background infor mation for later.
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Creative use of margins can help unclutter your page layout. The following
résume is off to a good start, insofar as the text is concerned, but its layout

is uninspired.

% File Edit Search Format Font Style

& @ BEES , 2 EHEE

Résumeé for

Helen Wheels, Ph.D. Chalk Sciences
1313 Rod Lane

Speedway, KY 36789

I 3l....I....l. I

Objective:
Senior management position in major chalkboard firm.

Recent accomplishments:
1. Developed the AutoErase blackboard, now installed in several major
government buildings.

2. Managed succesful effort to develop "squeakless” chalk for school i
market.

Start by inserting a ruler in the line following your name and address. This
will allow you to center this infor mation and leave the rest of the text in
the normal ragged-right justification. When you have more than one ruler
in a document, ruler settings affect all the text up to the next ruler. Also,
whenever you insert a new ruler, the new ruler is a copy of the one that

preceded it.
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You can, of course, change each ruler setting independently of the others.

% File Edit Search Format Font Style

E0 Idea 12
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: Résumé for
Helen Wheels, Ph D, Chalk Sciences
1313 Rod Lane
Speedway, KY 36789

| a@ BEE= B = EE
{ Objective:
Senior management position in major chalkboard firm.

Recent accomplishments:

1. Developed the AutoErase blackboard, now installed in several major
government buildings |

If you look at the left margin marker on the new ruler we inserted, you

will see that it consists of two parts. Clicking the mouse while pointing at
the marker will let you grab one of them. The position of the long marker
determines the location of the first line of a paragraph, and the black

triangle sets the position of the remaining lines of the paragraph. For
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résumés it is usually a good idea to inset the body of the paragraph from
its first line—especially when ticking off accomplishments. As you number
each accomplishment, press the Tab key to jump to the beginning of your
text line, and all remaining text will be perfectly aligned with the first line.

(Personnel managers like people who pay attention to detail.)

% File Edit Search Format Fom Style
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Objective:
Senior management position in major chalkboard firm.

Recent accomplishments:

1. Developed the AutoErase blackboard, now installed in several major
government buildings.

2, Managed succesful effort to develop "squeakless” chalk for school
market.

X Invented world's first "scratch and sniff” chalk for youth market,

presently available in 19 odors|

With these few pointers, you will be well on your way to creating an
irresistible résumé. Then you will have to develop a tactful form letter to

turn down all those job affers you won't be able to accept!
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Style

A good outline is often the key to a successful report. The layout of an
outline can help you organize your thoughts and point out gaps in your

presentation.

A key 1o good outlining technique is the nesting of different levels of detail.
Through the use of different type styles and indentation, your Macintosh
makes a perfect outlining tool. Your first step should be to set up several
tab stops on the ruler at half-inch increments. To set up a tab, simply move
the cursor into the ruler box containing the white triangles and pick up a
tab marker by holding down the mouse button. Drag the marker to the

desired place on the ruler and release the button.

Once your tabs are set up, you are ready to start your outline. If you want,

you can start with Roman numerals for the first level, capital letters for the
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second, Arabic numbers for the third, and lowercase letters for the fourth.
This method works well with any typewriter or word processing system,
but on the Macintosh you can also use different type styles to indicate
which level of the outline you are at. As with outlines created with other
tools, your major way of denoting levels will be the use of indentation. To
reach the desired indentation level, press the Tab key until the text cursor

is at the desired starting place.

83



& File Edlt Search Format Ffont Style |

klalAlalelnlAlalstlnlnlthnlnlnltlslAA;IAIQIAlnlAl?

aa SI=1E B=E=EEE

I. Background Information

A. Geography of entire region
B. Geography of local area

1. Mountains around Anchorage
2. Local valleys

C. Native residents

D. Migrants from the lower 48 states

11. Business Opportunities in Selling Refrigerators to Eskimos

A. Refrigeration needs of hunters and fishermen )

After you've written your report, you can edit your outline and turn it into

your table of contents.
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Edit

Format

MacWrite is tailor-made for the preparation of short reports. In fact, you
can create single-spaced reporis up 1o a length of about 10 pages or so

without running out of storage space in the computer.

When creating your report, you might want to start by setting up your
header 1o show the page number and leaving the footer blank. By putting
a few Returns in the header and footer, you can set the vertical margins to

suitl your taste.

85



As for the text itself, the main ruler should be set for 1 1/2 spacing (the
middle spacing option on the ruler). This produces text that is easy to read
and also lets you reserve single spacing for quotations from other books or
reports. Section headings should be in boldface type, and the title might be
set in 24-point type on a page by itself. To place text on a page by itself,
select the Insert Page Break option from the Format menu. This inserts
exactly enough space to start you on a fresh page. Eveﬁ if you add or

delete text before the page break, it will readjust its space automatically.

® File Edit Search BliuGL
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Font Style

Insert Ruler

Hide Rulers

Show Header
Show Footer

Set Page *...
Insert Page Break
Title Page

Refrigerator Sales to Alaska

Colstu Newcastle
Redundant Products Division
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If you do include quoted material, you may want to indent this material by
1 inch as well as enter it with the single space option from the ruler. To do
this, you need 1o insert a new ruler before entering your text.

(There is no truth to the rumor that you should restrict your report to four

quotes simply because that is a gallon.)

% File Edit Search Format Font Style
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refrigerator. For example, it is unlikely that they presently have a special

heated banana compartment to keep their bananas warm when they are
put in the refrigerator. Furthermore, in the words of Lewis Carroll:

:‘1I|lll'l .2- I |3 e B 1 Iq- b e s |5- | -‘&olulﬁulllnlll

Ly (rel
= == ===
' Alice looked on with great interest as the King took an
enormous memorandum book out of his pocket, and began
writing. A sudden thought struck her, and she took hold of the
end of the pencil, which came some way over his shoulder, and
began writing for him.

;llél.l.|,|2.|.I.|.|5.|.I.|.|4.|.I.|.!5.|.A.1.|6.1.I.|.l

Q@ =B = BHEIEIE

Now | know this may not be an obviously valuable quotation, but if you let

{ other people write orders for you, will they order your refrigerators? I
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As you are writing your report, you may wonder if you are running out of
storage space for your document. The easy way to find out is to select the
About MacWrite item from the Apple menu (the entry shaped like an
apple).

n File Edit Search Format Font Style
{ » Idea 14
refrigerator. For example, it is unlikely that they presently have a special

heated banana compartment to kKeep their bananas warm when they are

i putin{

‘lll Macllrite, the Macintosh Word Processor -

Written by Randy Wigginton, Ed Ruder, and

: A ]

[ Don Breuner of Encore Systems. %
Version 1.0

Memory free: 87%

i
Memory used: 13% o

@ =) ] ) (B

Now I know this may not be an obviously valuable quotation, but if you let

| other people write orders for you, will they order your refrigerators?
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This selection lets you know the percentage of space left for your
document. If you have less than 20 percent of your space left, you should
save your document and continue your report in a fresh document. We

show how to do this later.

Sometimes you may find that you still have space to add more material to
your document but you can't print it out. The solution to this problem is to
cut out the last page or so of your document (using the Cut command in
the Edit menu), save your trimmed document, Paste your “cutting” into a

new document, and reload your original document for printing.

If you are watching your memory space, this problem should rarely occur.
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&&y i 10515 REPORT COVERS

Fow can't judge a book by its cover, but sometimes your boss can. There
are many ways to make your repori appear more classy just by paying

attention to the cover page.

For example, if your report is going to be enclosed in a folder with a
cut-out window, arrange the title page so that the report title #2¢ your
name are perfectly framed by the window. This may take some
adjustment of the margins and type size, but it can produce very attractive

results.
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Selling Refrigerators
to Eskimos:
The Cold Facts

Colstu Newcastle

I

If your report will be presented with a transparent plastic cover, you can

use your cover space more freely. Don't get carried away with pretty fonts
—stick to typefaces that are easy to read and that present an image that is

in concert with the subject of your report and the tone of your company.
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Selllng Refrigeraters to Bskilmos:
The Cold Facts

Colstu Newcastle
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REPORTS Format

Let's face it, some of us are more long-winded than others, and when it
comes to describing the use of volcanic ash as "hamburger helper,” we just
need more space than MacWrite gives us for a single document.
Fortunately, all is not lost. When you get to the end of one portion of your
document (and you are low on space), you can save this document on your
disk and, using the same headers and footers, continue the treatise on a

new document.

| Format R

Insert Ruler

Hide Rulers

Open Header

Open Footer
Display Headers
Display Footers
Set Page #...
insert Page Break
Title Page
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Of course, there is the issue of page numbering. Because your pages are
numbered automatically, you need to have a way to renumber the first
page of a document so that the numbers continue from where you stopped
with the previous document. This is achieved through the Set Page #

command in the Format menu.

New page number?

( ok ] [ cancel ]

Just set the starting page number to the correct value, and no one will ever
be able to tell that your report was pieced together from several MacWrite

documents.
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mEA 17 MERGING MacWiie
DOCUMENTS Eait

Just as you may want to create a document that is quite long, often you will
want to merge some text from one document in with another. The easiest
way to accomplish this is to load the document containing the text to be
copied, select the text to be copied, and choose the Copy option from the

Edit menu. Let's use this section of our report from Idea 14:

refrigerator. For example, it is unlikely that they presently have a special
heated banana compariment to keep their bananas warm when they are

put in the refrigerator. Furthermore, in the words of Lewis Carroll:

Alice looked on with great interest as the King took an
enormous memorandum book out of his pocket, and began
writing. A sudden thought struck her, and she took hold of the
end of the pencil, which came some way over his shoulder, and
began writing for him.
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Now [ know this may not be an obviously valuable quotation, but if you let

other people write orders for you, will they order your refrigerators?

When the text is copied, you can close this document and load the docu-
ment into which this text is to be inserted. At any time, you can see the
text that you have copied by selecting the Show Clipboard option from

the Edit menu.
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Once your new document is on the screen, place the cursor where the text

is to be inserted and select the Pasie option from the Edit menu.

€ File Search Format Font Style

Cut HH
Copy #C

In additig b this peried, one of the lecser known

fragmen shown below. To date, no great. literary

significar] to it

Show Clipboard

Alice looked on with great interect as the King took an enorrmons
memoranduimn beok ont of his pocket, and began writing A sudden

thought struck hier, and she tock hold of the end of the pendil, which came

some way over his shoulder, and began wriung for him.

Notice that unless you have copied a ruler along with the text, your copied
text will assume the format of the new document. You can, of course,
change this by inserting a ruler in front of this text and setting the format

to your liking.
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By having a good collection of “catch” phrases in your library, you should
be able to create a powerful report with almost no original effort on your
part. As Bach is reported to have said, “Invention is nothing more than

undetected plagiarism.”
The Cut, Copy, and Paste features of the Edit menu are quite powerful in

that they let you move text from place to place within a single document as

well as from one document 1o another.
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REPORTS Selection Box I:: :3

All text and no pictures can make reports dull. One of MacWrite's advan-
tages is that it lets you incorporate pictures created with MacPaint into
your documents. Before you rush to fill your text documents with pictures,
however, be aware that pictures take up lots of memory, and sometimes
the best way to bring pictures into a document is to leave blank pages in

your text where the pictures are to appear and then, after printing out

your MacWrite document, replace these blank pages with your separately

printed MacPaint pictures.

99



I realize that this style of merging pictures with text lacks class for the true
Mac wizard. It means, among other things, that your report will be split

between the text portion and one (or several) picture files.

So, if you want to be a Mac purist, here is the easy way to merge pictures

with your text.

First, you have to have a picture to merge. (We discuss picture creation in
Chapter 4.) Once the picture is on the display screen, use the Selection

Box to select the portion you want to merge with your document.
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Your selection should then be copied using the same Copy function you

expect to find in the MacWrite Edit menu.

{ Undo *Z
Cut ad
Copy #C
Paste ®U
Clear

Invert

Fill

Trace Edges #*E
Flip Horizontal
Flip Uertical
Rotate
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Next, close MacPaint and load the MacWrite document into which your
picture is to be copied, select the insertion point for the picture, and select
the Paste option from the Bdit menu. Voi/é your picture has now been

inserted in with your text.

% File Edit Search Format Font Style
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Of course, the projected sales for 1985 show a slight downturn. If you look
at the preceding sales figures, however, the implications of this graph are
not so severe:

projected sales

79 80 81 82 83 84 85
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If you do not like the horizontal location of the picture on the page, you can
select it by “clicking” it with the mouse. This puts a box around the picture.
If you hold the mouse button down while pointing to the left or right edge

of this box, you can drag the picture to any horizontal position you want.

& File Edit Search Format Font Style
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Of course, the projected sales for 1985 show a slight downturn. I you look
at the preceding sales figures, however, the implications of this graph are
not so severe:

projected sales

L 79 80 81 $2 83 84 85 |
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Also, if the picture isn't the right size, you can shrink or expand it to your
heart's content. The way to do this entails placing the cursor in one of the
three small black boxes at the bottom of the box. Selecting the middle box
(by pointing at it and holding the mouse button down) lets you stretch or

compress the vertical size of the picture.

% File Edit Search Format Font Style
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Of course, the projected sales for 1985 show a slight downturn. If you look
at the preceding sales figures, however, the implications of this graph are
not so severe:;

profected sales

b 79 60 81 p2 84 85 o
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If you select the small box on the left or right side, you can stretch or
shrink your picture both up and down and in the direction of the

corresponding edge you have selected.

&% File Edit Search Fo

Font Style

Of course, the projected sales for 1985 show a slight downturn. If you look
at the preceding sales figures, however, the implications of this graph are
not so severe:

projected sales

L 79060 81620384 85

There is no question that small inserted pictures will make your documents

look quite classy. Just be sure that the result is worth all the effort.
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veowie  [0EA 1O TURNING THE
TABLES ON NUMBERS

Many business people are impressed by numbers. No matter what textual
information you may have in your report, they want the “cold hard facts,”
the "bottom line"—information that is often expressed in numerical form. [
have met people who behave as though they can learn more about a
company by staring at tables of numbers than they can by talking to the
people who run it. Since numbers can be very important, you should learn
how to create numerical tables that will impress the most determined bean

counter in your organization.

The key to good numbers is neatness. Neatness probably counts more than
accuracy—-especially if you are forecasting. I'm not sure why, but numbers

people are taught at an early age to distrust numbers that aren't neat.



Since you will want to create tables with MacWrite, you should be aware of
a wonderful tool that lets your numbers be perfectly lined up: the decima/
Zab. No, this isn't a soft drink for the perfect “10,” it is a special tab stop

that is shown in your ruler as the white triangle with the dot in the center.
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To see how it works, let’s create a sample table. Set the ruler with a
normal tab (the plain white triangle) at the 2-inch marker and place

decimal tabs at 3, 4, and 5 inches on the ruler. These tabs are positioned
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the same way you position other tabs. Move the cursor inside the tab box,

press the mouse button, and drag the tab to its final position before
releasing the button.

Once the tabs are in place, you are ready to start creating your table. Use

the Tab key to move from position to position while creating the table.

& File Edit

Search Format

font Styie

Atlnlala&%&;lnl;$sal a

Ba=E = = = E =
Expense 30 31 82
Food 134.60 214.63 300 95|

108



Now, as you enter the remaining lines in this table, you will notice some-
thing quite interesting. All the numbers will appear with their decimal

points lined up one above the other.

6 File Edit Search Format Ffont Style
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Expense 80 81 82

Food 13460 21463 300.95
Rent 320.00 1000.25 $10.00
Car 17.50 5934.32 200.00|

With this sort of precision you can probably convince your accountants to
let you open a branch office in the Bahamas—how could they fail to be

impressed?
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Once you have finished your table, you may find that the column spacing
isn't what you had in mind. Not to worry. To fix your column spacing, just
grab a tab and move it 1o the desired location. Once you do this, all your
pretty numbers, like Little Bo Peep’s sheep, will foilow, dragging their
decimal points behind them.

& File Edit Search Format Font Style
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Food 134.60 21463 30095
Rent 320.00 100025 81000
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LIBRARIES Edit
File

Rulers (except for the first ruler in a document) can be cut, copied, and

pasted just like text. This lets you create a library of useful rulers that can

be kept in one document (called, perhaps, Ruler Library).
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By using the ruler library document as the basic form for all your
documents, you can use Copy and Paste from the Edit menu to select
rulers to be placed wherever you want them to appear. Once you have

placed all the rulers, you can delete the "library” at the beginning of your
document.

If you use this approach to document creation, you must remember to use
the Save As choice in the File menu when saving your document,

otherwise it will be saved under the name Ruler Library.

| Frie I

New
Open...
Ciose

Save

Save As...
Page Setup
Print...
Quit
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Edit

Now that you know about decimal tabs, you will no doubt be whipping out
impressive tables. Of course, it is almost as important to have your
numbers added up properly as it is to have them nicely lined up. Though
it is likely that you already own a pocket calculator, your Mac has a
built-in calculator that lets you perform the traditional add, subtract,

multiply, and divide calculations you are likely to need.
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To see your Mac calculator, select the Calculator option from the Apple

menu.

® File Edit Search format Font Style
Idea 21

and, accordingly, we will be bllowing amount of molten
lava to your next geology picnic on any day you choose. Assuming that you

want to use 15 cubic yards of lava at a cost of $1.47 per cubic yard

(including heating), you would then owe us

As you look at the calculator keyboard, you will notice that the add and
subtract keys appear normal but that the Mac uses the asterisk (*) for
multiplication and the solidus (/) for division. The tradition of using these
characters for these functions has its roots firmly placed in the folklore of

computer language design and is not worth arguing about.
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You can press the calculator keys in one of two ways. First, you can use the
caiculator by pressing the corresponding keys on the keyboard. Second,
you can select the keys by pointing at them with the mouse and clicking
the button 1o make the selection. In this case, typing will probably be a lot

faster than using the mouse.

Once you have a calculation that you want to include in your document,
simply select Cut from the Edit menu. You can then select the screen
location where you want the result inserted (this will cause the calculator
to disappear) and then select Paste from the Edit menu to insert the

number.
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Edit

Print

Just as you can use your Mac to create spiffy letterheads, you should be
coordinated in your design effort and use it for the creation of mailing
labels as well. If you are in the habit of sending out packages or large
manila envelopes filled with valuable objects, you should take the time to
be sure that your mailing label reflects handsomely on your company. The
easiest way to do this is to model the return address on your mailing label
on your letterhead, only with a smaller type size. Once you have chosen

your basic format, you can make a blank form that contains several label
forms.
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Tayno Ss2it Panciling Company

12 Plywood Drive, Sherwood Forest, IN 47678

To:

Vayne Saoil Panciing Company

12 Plywood Drive, Sherwood Forest, IN 47678

In creating these forms, you will want to leave enough space for names and

addresses, and you will want to set up tab stops for these entries.
Depending on the uitimate size of your label, you should be able to get six

or eight labels on a single sheet of paper.

Wayne 8a9is Paneling Company Vayne Seet: Paneling Csmpany

12 Plywood Drive, Sherwood Forest, IN 47678 12 Plywaood Drive, Sherwood Forest, IN 47678
To: RuthLess To: Moe delLawn
P.0.Box 3465 56 Tulip Way
Fountainhead, NB 87767 Landscape, AZ 76567
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Wayno 5996 Pancling Company Hayne B89t} Pancling Campany

12 Plywood Drive, Sherweod Forest, IN 47678 12 Plywood Drive, Sherwoed Forest, IN 47678
To: Helen Back To: Gerry Mander
314 Pie Circle 6969 Rockwell Ct.
Ellipse, Wl 65432 Screwhaven, MA 01245

Once you have filled out the names and addresses of your labels, you are
ready to have them printed. You have two choices here. You can either
print your labels on ordinary paper and then glue them on your packages
with rubber cement, or you can purchase peel-off label stock in 8 1/2-by-

11-inch sheets and print your labels on this material directly.

After your labels are printed, simply cut them to size and glue them in

place. The result will be very impressive.
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Font

Print

Well, your hard work has paid off, and you are finally getting to present
your pet project to the board. Naturally, you won't be alone—several other
co-workers will be competing for scarce resources. And as if that weren't
enough, Snerdly Swimp just got a brand new computer (but not a Mac), and

he is planning on using it to help with his presentation.

Now you, of course, know exactly what you are going to say. Your only
problem is in the preparation of good visual aids to help maintain interest
while you are describing your project. There is no question that visual aids
can play a pivotal role in the acceptance or rejection of an idea. As a result,

this will be the area where you will knock Mr. Swimp into the mailroom.
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The Macintosh is a perfect tool for making overhead transparencies. First
you have to create your masters, print them using the high-quality print
option, and then make copies of your masters onto plastic film. There are
two types of copiers that will let you do this. Acceptable copies can be
made using conventional xerographic copiers, but the best-quality charts
are made using a thermal copier with special heat-sensitive transparency
material. Since thermal copiers are much less expensive than xerographic
copiers, it is ailmost worth having one around purely for making

transparencies.

In planning your presentation, you need to know a bit about the size of
your audience, their attention span, and the subject matter you want to
cover. The worst thing you can do is try to get too much infor mation on

one page, as in the example on the opposite page.

I have had to suffer through too many boring presentations that relied on
the use of a single transparency that tried to cover far too much material
and couldn't be read in the second row. When confronted with such a
presentation, I tend to devote my time to solving crossword puzzles instead
of listening to the speaker.
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Research Efforts for the Next Six Years

1984 - Complete hybridization of square tomatoes so slices fit better on
bread.

1985 - Develop avocado with smaller seed.

1986 - Start design of edible automobile for people who plan on running
out of gas in the desert.

1987 - Find way to completely replace beef with sawdust for fast-food
hamburger market.

1988 - Develop line of salad dressings from used motor oil.

1989 - Complete installation of solar-powered asparagus field.

Staffing for These Projects
Dr. Fern Begonia
Dr. Hy Acinth

Dr. Will O'Tree

Key issues, never to be forgotten

We are performing this research as a natural branch of our business, and
though we may occasionally bark up the wrong tree and pine for lost
success, we vow never to leave the field in which we have toiled and from
which we have harvested such fruitful results.
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The rules for making good overheads are quite simple: 24-point type
works; smaller type doesn’t. Oh, it's true that you can occasionally use
18-point type for some things, but in general you should restrict yourself
to presenting your text in 24-point type. Avoid cluttered fonts. New
York, Geneva, Toronto, Monaco, and Chicago all work fine. Fancy fonts
like London are hard to read at any size. Don't use too many fonts on one
chart. If you need to emphasize certain words, use italics and boldface.

Experiment with the Shadow style for titles to see if you like it.

Key issues, never to be forgotien
We are performing this research as a

natural branch of our business, and
though we may occasionally bark up
the wrong tree and pine for lost
success, we vow never to leave the
field in which we have toiled and
from which we have harvested such

fruitful results.
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You also need to think carefully about the content of each overhead. No
more than one major point should be visible on the screen at one time. If
you display several points, your audience will read ahead while you are
describing your first one. Remember, you are controlling the flow of
infor mation in your presentaion. Make sure your visual aids keep you in

control.

If you do these things, Swimp won't have a chance!
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FOnt

While you are busily working on your presentation, you will no doubt find
that you have several lists, like the one below, that need "bulleted” items—
topics that you want to tick off, one by one. To make these lists into sit-up-
and-take-notice charts, you will want your bullets on the left side of the

page and all your text neatly lined up on an indented left margin.

Reasons for funding this project:

Our corporate survival depends on a steady stream of new
products.

The success rate of our previous efforts has been high.

The proposed product fits our market. . ..
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To set up your left margin properly, move the solid black triangle portion
of the left margin to the 2-inch mark and leave the long margin marker at

the 1 1/8-inch mark.

% File Edit Search Format Font Style
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This will let you line everything up perfectly. The long margin marker
shows where the first line will start printing, and the second marker shows
where subsequent lines of text will appear until you press the Returna key.
To enter your bulleted text, type a bullet by pressing the Option key and
typing the 8 key. Next, press the Tab key to move to the inside margin
and start typing your text. When the first item is finished, press Return
twice, and repeat this process until all your items are entered. In no time
at all, you will have produced bulleted charts that will knock your audience
off its feet.
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Reasons for Runding This Project

2

e Our corporate survival depends
on a steady stream of new
products.

e The success rate of our previous
efforts has been high.
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Reasons for Funding This Project

Our corporate survival depends
on a steady stream of new
products.

The success rate of our previous
efforts has been high.

The proposed product fits our
market.

Freddy Jones was funded last
time, so it 1S my turn now.
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Now that all your overheads are ready for the big meeting, you find that
you have been selected to post the meeting announcement. That means it's
up to you to make sure that people will want to come. This is a special
challenge because the bulletin board is usually filled with other meeting
announcements, advertisements for condo rentals, complaints about the

soft drink machine, and other pressing business news.
Of course, none of these distractions will stay you from your appointed

rounds—especially when you use your Macintosh to create the meeting

announcement.
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The exact form of the announcement is a matter of personal taste. I prefer
the discrete understatement—starting, perhaps, with a 24-point headline to
capture attention and then quickly moving to 14-point type for the body of
the announcement. Remember that your announcement needs to tell the
subject of your meeting, as well as its time and place. Also indicate who

should attend—especially if they know what's good for them.

% File Edit Search Format Ffont Style
====———————————— |dea 25

The Future of Gur Company

[T

A presentation by ...

o Don deVino
. sSnerdly Swimp
. A cast of thousands

The meeting plface ...
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The Future of Gur Company

A presentation by ...

. Don deVino

. Snerdly Swimp

. A cast of thousands

The meeting place ...

. the Dew Drop Inn

On ...

. April 11, 1984, at 4:00 PM

Who should attend:

makers can attend if they want to.

. All key decision makers. Lock decision

With a meeting announcement like this, you will have a packed house!
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Ah, the sweet joys of success! Your presentation was so well received that
you got a special bonus—enough to let you buy a Macintosh for your home.
I'm sure that you were tempted by the idea of geiling a new car or buying
some new clothes but were just overwhelmed with how impressive it

would be 1o have a Mac for home use.

Well, come on, you won't impress anyone if they don't know you have it.
What beiter way to impress your friends than by throwing a Big Mac
party! Of course, you have 1o choose your guest list properly. You don't
want 1o let things get out of hand—perhaps 50 or 60 people, but no more,

or your one-bedroom apartment would get too crowded.
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Now, any time I have 50 people come to a party, I am lucky to remember
the names of half of them—and that's before the first drink. The solution to
this is easy. Have everyone wear a name tag! There are two ways to get
name tags for your guests. You can buy some blank name tags at the
stationery store and have each guest fill out his or her tag with a felt-
tipped pen, but this clearly lacks class. The better approach is to create a

name tag form and let people type in their own names.

Once a sheet of tags is filled in, you can print them out on label paper, cut
them to size, and stick them on the appropriate people in the appropriate

places.

There is a hidden advantage to letting people create their own name lags
on the Mac—-by saving the list of names, you will be able to see who came

to your party.

And to think that they laughed when you sat down at the keyboard . . .

Hello!
My name is
Celle Leter

and yours isn't/
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Hello!

My name is
Dos Reimey

and yours risn 't/

Hello!

My name is
Fren Testlc
and yours r1sn’t/

Hello!

My name is
Kendall Wicke
and yours 1sn’t/

Hellol

My name is
Ernest Mony
and yours isn't!
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ADDRESSES

As the ever upwardly mobile person that you are, the time will come when
you need to let everyone know that you have moved. Also, you might find
yourself entering a long-lterm commitment and want to change your name.
Clearly this calls for an announcement that shows more class than the

typical postal card offered by the US. Postal Service.

Using MacWrite, you can create your own custom posi-card design that

tells the world exactly who you are and how to reach you.



Announcing/

2345 Peapot Lane
Cleft Palate, NB 65432

has married Fred Kissinger
and is

Awanda Hughes Kissinger now.

Her new address is:

17 Xensington Circle
Snob Hill Estates
Sunova Beach, CA 98765

Mail sent to the old address
will be used to start
forest fires.

Once you have created this powerful little missive, take a high-quality
print of it to your local “instant press” and have them print it on some post
cards for you. With a little effort on your part, everyone will know you

have moved.

And, no, we won't all be happy about it either.
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AS A DATA BASE

So far, the ideas I have described that use MacWrite also use the printer.
Our goal has been the creation of documents. But MacWrite is sufficiently

powerful that it can be used to let you build an infor mation retrieval

system.

Suppose that you want to keep track of your business colleagues. Using
MacWrite, enter their names, companies, addresses, phone numbers, shoe
sizes, and any other information that you find to be of pivotal importance
in your business dealings. To make this file easy to read, you may wish 10
leave a blank line between entries. Don't worry about alphabetical order,

just enter the names as they come o you.
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Wayne Scott Paneling Company

12 Plywood Drive

Sherwood Forest, IN 47678

Doug A. Hole

Extrax Construction Co.

1435 Wyworry Lane

Felthat, AK 76543 I

Ruth Less
P. 0. Box 3465
Fountainhead, NB 87767

Helen Back
314 Pie Circle

Once the names and addresses are inserted, save the document under some

file name such as Contacts, so you know what it contains.

Then, the next time you want to know the address of Celia Later, all you
have to do is select the Find option in the Search menvu, enter Celia

Later, and click the mouse button in the Find Next box.
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® File Edit Search Format Font Style
1 Find

Find what |Celialater

Ruth
P.O.|(Find Nent ! @® Whole Word O Partial Word
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Helen Back
314 Pie Circle
Ellipse, W1 65432

_elia Later

16 Farewell Lane
Gunny Sack, VA 43216

Moe deLawn
56 Tulip Way
Landscape, AZ 76567
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Presto—you are immediately led to the desired infor mation!
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AND PORTRAITS

I'm sure you won't know how you ever lived in modern society without
knowing the information I'm about to share, but it just goes to show how

resilient we are as human beings.

You may never have noticed that there are two general ways Lo orient a
piece of paper. If information is printed on the paper with the long side
held up and down, this is called the porfrast mode. If the infor mation
appears in such a way that the long side is held horizontally, this is called
the /andscape mode. If the information is printed on a diagonal, this is
called the bozre mode, and you need to learn how to insert your paper in

the printer properly.

The origin of the names porirast and /andscape is easy o undersiand.
Portraits tend to be painted so they go up and down, and landscapes are
painted so they extend horizontally. There are exceptions, of course: Some
Japanese landscapes are quite vertical and are painted that way, and any

complete portrait of Dolly Parton . .. oh, never mind.

File
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By now you are wondering why I have chosen to impart such important
information to you. The reason is that MacWrite lets you take your pick
when printing your document. When you select Page Setup from the File
menu, you are presented with the option of printing your document in
either the Tall (portrait) or Wide (landscape) orientation. (The Handsome
option should appear for completeness, but what did you expect from a

computer that costs less than $30007?)

&% Edit Search Formatl Font Style
MaclWrite

Paper: @ US Letter (A4 Letter

QO US Legal O International Fanfold
Orientation: @ Tall (O Tall Ad justed O Wide
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Normally you would choose the Tall option, but sometimes, if you are
making overhead transparencies, for example, you will want them printed
out in landscape mode. Fortunately, you don't have to make any adjust-
ments 10 your printer or paper. When you pick the Wide option, your

document will be printed sideways.

Text printed with the Wide option tends to be a bit more widely spaced
than it is when printed in portrait mode. This can make it a little easier 10

read.
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Reasons for Funding This Project

. Our corporate survival depends
on a steady stream of new
products.

° The success rate of our previous

efforts has been high.

® The proposed product fits our
market.

* Freddy Jones was funded last
time, so it is my turn now.
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ABOUT PLAIN TEXT e

When saving your documents to disk, you have probably noticed that one

of your options is labeled Text Only.

Save current document 8s | yrite/Paint

The Great Gatsby

O Entire Document @ Text Only

If you choose 10 save your document with this option, you will save a lot of
space, but you will save only the text portion of your document without

any information regarding for matting, fonts, styles, pictures, page breaks,
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headers, or footers. The principal use of this feature is 10 save documents

that are to be used with other application programs for your Macintosh.

However, if you are creating a large document and you don't need any of

it, Text Only can save some disk
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As you can see, the entire document occupies 11,000 characters of
memory, whereas the Text Only document occupies only 8,000 characters

of memory on the disk.

Getting a Text Only document back into MacWrite takes a little effort.
First, you should know that you can only load such a file from the "desk-
top”; you cannot open it using the Open option in the File menu. To bring
a Text Only file into MacWrite, you must first select the document by
clicking it once with the mouse and then select the MacWrite icon by

holding down the Shift key and then pressing the mouse button.

o BIEE Edit

UView Special

Duplidate 365K in disk 34K available
Get Info 381 ;
Put Back @ E Q}"
s Close
Close Al
E Print
Eject
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Once both icons are selected, you can choose the Open option from the File
menu, and your document will appear on the screen in pure New York

type, with no embellishments whatsoever.

Now that we have given you a taste of text, the next chapter will show you

the power of pictures.
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Chapter 4
THIRTY WAYS TO WORK WITH PICTURES:
A COLLECTION OF IDEAS THAT USE

MACPAINT
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EQUATIONS Text

Line

192431 WRITING MacPain @
A
i

FontSize Selection Box :_'--E
Edit Font

Now that you know all about MacWrite, you are probably the envy of the
neighborhood. After all, you are able to create documents with your
Macintosh that are virtually impossible to create with other types of

computers, and you don't have 10 be a computer expert to do it!

Of course, there are some things that you might like to do that are not
possible with MacWrite. For example, suppose you want to include some
mathematical equations in your document. Many mathematical equations

have subscripts and superscripts in them, and the early versions of
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MacWrite do not provide this capability. Fortunately, you can use
MacPaint to create your equations and then paste them into your text

document.

To use MacPaint, simply double-click the MacPaint icon on the
Write/Paint disk.

% File Edit Diew Special
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Once MacPaint is ready to use, you can select any of a wide variety of
options for creating images on the screen. For our present task, we will

choose the Text option by clicking the mouse button in the menu box that
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contains the big letter A. This selection allows us to place text anywhere
we want on the screen. You should move your cursor 10 a central place on
the screen and click the button to indicate where your text will appear.
Next, select the desired font from the Font menu. For this example, we

will use the Geneva font and pick the 14-point size from the FontSize

menu.

You will notice that you have many more size options in MacPaint than you

do in MacWrite—I will describe these options as we use them.

% File Edit Goodies Font 2N Style
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Now that we have selecied the typeface and type size, we are ready 1o

start writing our equation. For starters, we will create the equation for the

length of the hypotenuse of a right triangle, ¢ = al + p2

Notice that I left some space after the letters on the right side of the equal

sign. This is to allow room for the superscripts.
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Once this line has been typed, you are ready to add some superscripts to
the letters a and b to indicate that these values are to be squared.
Superscripts should be in a smaller type size than the rest of the equation.
Before pulling down the FontSize menu and selecting a new type size, you
should know that there are some fundamental differences between
MacWrite and MacPaint in their handling of text. In MacPaint, any change
in font, size, or style is immediately reflected in all text entered since the
last click of the mouse, whereas in MacWrite, changes affect only selected
text or the next text to be typed.

So, before selecting a new type size, relocate the cursor to the upper right
corner of the letter a and click the button. Select 9-point type from the
FontSize menu and type the number 2. Move the cursor to the letter b

and type 2 again.

FontSize

Molplolinit
10
12
14
18
2{d)
36
48
72
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% File Edit Goodies Font FontSize Style
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We are almost done, but we need 10 show that the square root should be
taken of all the items to the right of the equal sign. To draw a square root

sign, select the Line tool from the MacPaint menu on the lefi side of the

screen.
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c = a?+b?

Move the cursor 1o the starting point for your square root sign and click
the mouse button. When you do this, you will mark one end of the line.
Now, as you move the mouse, you will see a line stretch from this location

1o the current mouse position. When you have the line where you want it,
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click the mouse button again to freeze the line. Repeat this process for the

remaining two lines, and you will be finished. (Pressing the Shift key will

let you draw accurate horizontal or vertical lines.)
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Now that your equation is finished, you can select it and paste it into your

text document using the technique I described in Idea 18.

This approach to entering equations may appear a bit cumbersome at first,
but it does let you create quite beautiful documents and should impress

your scientific colleagues—especially if your equations are correct!
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Rectangle

Line Width | V&=

Text

Selection Box

Although our previous use of MacPaint has been for the creation of images
that are pasted into a text document, you will find that most of your
MacPaint images will stand alone. (Note that even though it is 0K to have
your pictures stand alone, you should never do Chinese cookery by
yourself because, as it is stated in the well-known saying, “You'll never

wok alone.” But I digress.)
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One of the good uses of MacPaint is the creation of graphs. Graphs are
easier to read than tables of numbers and can convey many types of
information in a very clear form. The key to the creation of good graphs is
to keep them uncluttered. Precision is usually not so important in graphs,
especially when you are irying to show trends. As a result, you can
typically set your graph points on a grid. MacPaint has a built-in grid,

ready for your use. This grid can be selected from the Goodies menu.

iLGUIGES Font  FontSize Style
FatBit Lde
Show Page

Edit Pattern
Brush Shape
Brush Mirrors
Introduction
Short Cuts

29453 5533353343 8348085

Once the grid has been selected, all cursor movements on the MacPaint

screen will be on grid points. From your rough sketches, you should know
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the range of values needed on each graph axis. Let us suppose you need to

create a graph that has 10 markings along the y (vertical) axis and 12

markings along the r (horizontal) axis. You should start by drawing a box

for your graph using the Rectangle tool in the MacPaint menu and

selecting a medium-width line from the Line Width toolbox at the bottom

left of the screen. Next, create your box by clicking the mouse at the upper

right corner of the box and moving the mouse 24 grid units to the right and

20 grid units down. Once the box is of the right size, click the mouse

button again to freeze a copy of the box on the screen.
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Next, label each grid position on each axis. MacPaint has some special tools
to make this task quite pleasant. For example, when you are placing
numbers along the y axis, you want to have them aligned by the right
edge of the number, not the left edge. To do this, select the Align Right

option from the Style menu before typing these numbers on the screen.

vAlign Right
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Similarly, you would use the Align Middle option when typing the

numbers at the bottom of the graph.

Labeling your graph and the bottom axis is siraightforward—simply select

the place where text is to appear and, using the Text tool, enter the

appropriate legends.
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Entering text for the vertical axis label is a little trickier: We want the text
to appear sideways. Even this is no challenge for MacPaint, however. All
you have to do is pick a clear area of the screen (the middle of our graph is
just fine at this point) and type the text as you want it to appear. Next,
select this text with the Selection Box. If you now pull down the Edit
menu, you will see an option called Rotate. If you select this option, your

text will be rotated 90 degrees.
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To finish the axis labeling, move the cursor inside the selected box until the
cursor turns into an arrow. Press the mouse bution and pull the label to its

final position. When you let up on the mouse button, the label will stay in

place.
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For accurate placement, you should "turn off” the Grid option in the

Goodies menu before positioning the text.
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At last you are ready to draw your lines in the graph. You can use the
Line tool with a thin line to do this. If you want your endpoints to appear
on grid points, be sure that the Grid option has been selected. Once your
line is drawn, your graph is finished and ready to be printed with the

Print option from the File menu.

Term Paper Effort

level of effort
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As you continue your climb in the business world, you will find pie charts
to be valuable tools for presenting information to others. Pie charls can be
used only for certain types of information, however. You can use them to
show the breakdown of some total amount--for example, the fraction of
people with above-average intelligence. (Amazingly, this fraction has
remained near 50 percent for all of recorded history.) Our federal budget

is often broken down into a pie chart because:
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¢ Pie charts can be understood by morons.

¢ The budget breafdown takes your mind off the budgetl s/ze

Since pie charts are usually circular, with spokes radiating from the center,
you need to know how to create a circle with MacPaint. The easiest way to
make a circle is to use the Grid opiion and then pick the Circle tool from
the main MacPaint menu. Press the mouse bution at the upper left corner
of the square that would completely enclose the circle and move diagonally

down and to the right until your circle is the right size.
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You should count the number of grid units you have moved when creating
the circle. As long as this number is even, you will have an easy time

locating the center, since the center will lie on a grid point.

Next, mark the center. One way to do this is to use the Line tool to draw a

line from the top of the circle to the center.
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To draw the rest of your lines, turn off the Grid option, unless you are
drawing lines to represent 25, 50, or 75 percent. As you draw your lines,
just estimate the percentages—if you are off by a little bit, no one will

notice.

File Edit Goodies Font FontSize Style
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Once the lines are in place, select the Fill tool from the main MacPaint
menu and fill each of the wedges with an appropriate pattern. Choose your

patterns so that they are clearly distinct from each other. This will keep
your chart easy lo read.
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Finally, label your pie chart and draw lines from the labels to any small

wedges so that each label gets properly matched to its piece of the pie.

Average Use of Student Time

- study

Sl i e e * ~eat

entertainment/ N
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Text A

Goodies

B

Bar charts are handy when you are trying to impress somebody with the
growth of your business. If your business declined last year, you should
use a graph and then refer to the “slight dip in the graph.” But if your sales

are climbing like a rocket, bar graphs are the best 1ools to use.
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The border and legends of your chart are made the same way they would
be for a graph. The easiest way 1o make your bars is with the Filled
Rectangle tool from the main MacPaint menu. Pick an appropriate fill
pattern—a simple array of dots, perhaps—and use the Grid option to make

sure all your bars are the same width.
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If you want to put numbers on this chart, they should be placed at the top
of each bar.
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MacPaint U@EA 35 MAKING
Selection Box FANCY

Pattern BAR CHARTS

Eraser

Text

Did you say that you were in a pinch because Snerdly Swimp is using bar
charts too and they look a lot like yours? Well, here’s one way to dress up
your charts. Let’s say you are in the pizza business and you want 1o show
how many pizzas you shipped for the past five years. Instead of using

filled bars for your data, use little pizzas instead.



Create a little pizza with a filled circle and put a legend on your chart

showing that each circle represents 100,000 pizzas.
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Next, select your pizza with the Selection Box (Lasso) and start stacking
up your columns by holding down the Option key when you click the

mouse button to drag a copy of the pizza to a new location. If the Option
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key is held down when the mouse button is pressed, the original pizza will
be left behind. Repeat this process for each pizza in the column, and your
chart will be finished in no time. You can use the Eraser from the main
MacPaint menu to erase part of the top of your last circle if you need to

represent fewer than 100,000 pizzas.

Gotcha, Snerdly!

&) - 100,000 pizzas }
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pEA 36 MAKING 3-D
CHARTS'

MacPaint

Filled Rectangle

Rectangle

Text

OK, so you are in the natural fertilizer business and you can't think of an

appropriate emblem to represent 100,000 pounds of steer manure. In

your case, you will need to rely on another technique 10 make your bar

chart stand out: three-dimensional bars.

The easiest way to create this chart is first 1o make a normal bar chart

using solid black bars. Next, pick solid white as the fill patiern, turn off the

*No special glasses required.

IS
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Grid option, and, using the Filled Rectangle, overlay the black bars with
white bars, each of which is staggered up and to the left by just a bit. This
will create a shadowed effect that will make your chart stand out above

the rest.

1 2 3 4 5 6 7 8

178



PEA 34 GETTING
ORGANIZED, CHARTWISE

Style
Goodies
Edit

File

MacPaint

Text

Rectangle

Line

Line Width

So far in this chapter we have been focusing on business applications for

MacPaint. One of the most important charts that can be created for some

businesses is the chart of the organization itself. In my years in business, I

have found that companies that care a lot about organization charts tend to

reorganize with great frequency. In fact, one of the constraints in

corporate reorganization is the amount of time it takes to create a new

organization chart.

........

FontSize
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If you are a chart climber yourself, you will be pleased to know that
MacPaint lets you create pretty organization charts in a jiffy. If you are

insecure about your job, you may not be so pleased to know this.

The organization chart should show the company or division name centered
at the top of the page. Next, the names and titles of key people (those who
have the key to the executive rest room) should be entered in a plain 14-
point type such as Geneva. Use of the grid can help with alignment. To
enter the names and positions, use the Align Middle option from the

Style menu.

vPlain L 3P

Bold *B
1t8lic 31
Underiine J*u
Oujtliinie 380

Shadaom %S

Align Left 8L
vAlign Middle 3M
Align Right 38R
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After typing each name, press Return and type the title. You should place
each name in its approximate final location to get a feel for the appearance

of your chart.
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Once the head honchos have been entered, you can start entering the staff
names underneath theirs in 12-point type. (Yes, Virginia, rank has its

privileges.)
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For the style chart | will demonstrate, the column of names is entered

using the Align Left option from the Style menu. Just pick a starting

point for the first name and start typing, using Returns to space out

the names vertically.
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If you are running out of room near the bottom of the screen, you can shift
your window to a lower place on the page by selecting the Show Page
option from the Goodies menu. The Show Page lets you see the
placement of your work on the actual page. Since il's very small, you won't
be able to make it out. Don't worry; everything is there. You will see it all

when you make a print-out.
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To shift the window, move the cursor inside the window boundary (shown
as a dotted line), press the mouse button, and pull the window down to the

desired location.
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If you want to move the window vertically, hold down the Shift key
before pressing the mouse button. When the window is where you want it,
release the mouse button and select OK to return to the main screen. At

this point you can keep adding new names to the columns.
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Once all the names are in place, you are ready to enclose them in boxes.

When using the Rectangle option in the MacPaint menu, you may

accidentally make a box the wrong size. If you do, simply erase it with the

Undo item from the Bdit menu.
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After drawing all the boxes, connect them with straight lines to finish the

chart.

Wimple Widget Corp.

Jack F. Alltrades

b——4

Steve Adore

— | Elhe Vator

— 1 Jim Shu

President
1
| 1 1
Titus Canby Dick Chunéry Win Alotte
Y P Finance| |VY.P.Publications Y. P Yice
—1 C. Nile —1 Doris Open —1 Teri Yaki
— N.D. Cysive —| Pam Perd | Ruth Less
— P. Green | — Gloria 5. Morn| [~ Rob Z. Banks
—| Doe Raimey —| Bee Gud 1 willie Makit

 ——

Shirley So

Once this master chart has been saved on the disk, you will be ready to

create a new one whenever it is needed.
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The same techniques used for organization charis can be used to create

flow charts. The major graphic difference is that flow charts often have
decision points in them. Many traditions abound; one is that decision items

are placed inside diamonds instead of reciangles.
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Working from your sketch, enter all the text items first, then enclose the
items in their respective boxes. To draw a diamond, you can use the

Polygon item in the main MacPaint menu.
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Nezxt, interconnect the boxes using straight lines. By selecting a thicker
line, you can make the chart easier to read. Also, arrowheads at the end of

each line will reinforce the direction of flow in the chart.

Finally, add the appropriate yes or no labels to the branches on the

decision points, and your chart is finished.

Is It A Duck?

Look at animal

A ?
eb Feet Give Me

A Break

_)j sorry

It
Is
Not

A
ﬂ Duck!

Do Birds
Have Lips?

It Is A Duck!
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924 39 MAKING MacPairt
BUSINESS o || A

CARDS Rectangle

Roundtangle C)

Style Font

Print FontSize

What's that? You've gone into business for yourself and you don't have
business cards? That's as tacky as installing a parking meter in your
bathroom. Fortunately for you, all is not lost—you have your ever-ready

MacPaint business card design system at your disposal!

Since your entire perceived worth as a human being in the business
communily may depend on your business card, you should design it with
care. First, you should know what kind of infor mation to put on your card.
It should include your company name (make one up if you need to), your -

name, your title (make that up too), your address, and your phone number.
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In designing business cards, some people think that you should be able to
lay a quarter on the card without having it touch any text. The point is to
keep your card uncluttered. Since a business card is only 2 by 3 1/2

inches in size, this is a challenge.

You can have your card read vertically or horizontally. Because it is more
common, I will illustrate a horizontal card design. When printed on your
Imagewriter printer, each grid space is 0.112 inch. You should thus design

your card to fit inside a box 18 grid units high by 31 grid units wide.
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Once you have drawn this box, you are ready to start experimenting with a
card layout. Try different typefaces and alignments until you get what you
want. For a special treat, you may want to put a border on your card. The
Roundtangle (that's the rectangle with round corners) from the main

MacPaint menu can {ook nice.

~Sunepet Lighting }?{ ,

Shanda Lear
Nice Person

L 12 Floodlight Yay, Lobeam, FL 33905

You can also use other graphic images on your card if you wish—after all,

your business card should reflect your personality and style.
When you take your business card to the print shop, they will show you

several colors of card stock from which you can choose. A colored business

card can be quite an impressive departure from the traditional white.

193



40

MacPaint IDEA 40 FANCY
i _;: Selection Box LETTERH EADS

FontSize
§_tyle

Edit

Though a pure-text letterhead of the sort described in Idea 5 may serve all
your needs, you should be aware that graphic images can dress your

letterhead up quite a bit.
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Your first step should be to create your letterhead with MacPaint. Don't
worry about horizontal positioning—you can adjust this once your

letterhead is transferred to MacWrite.

% File Edit Goodies Font FontSize Style
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Once you have your letterhead drawn, select it with the Selection Box and

choose the Copy option from the Edit menu.
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Next, start MacWrite and paste the letterhead into the document. Adjust
the horizontal position to your satisfaction and save this document as your
new letterhead. Enter text with MacWrite below the letterhead as you
would normally. The only difference you may notice is that you can't use

MacWrite to change the text in the letterhead itself.
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pliates Piffg. Coa
Exhale, M1 54321

April 25, 1984

Candis Dented
Bentworks Metal Stamping
Bentworks, OH 45678

Dear Ms. Dented:

I am extremely distressed by the fact that your last shipment of compass
needles was painted incorrectly. As a result of your sloppy work manship,
all the north ends of the needles point south. This has not only caused
consternation among our customers, it has even caused some of them to
proclaim that "he who has a Tates is lost!”

You will be hearing from my attorney within the week.
Pointedly yours,

Millard Tates
President
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MacPaint U@E&41 MONTHLY
Line Width CALENDARS

. Text

Are you one of those people who has activities booked months in advance
but who doesn't know what is happening today? I am, and 1 would be lost
without a personal calendar. MacPaint lets you create calendars that can
be used for anything from your private schedule of sauna visits to a

sign-up sheet for the corporate conference room.



You should start by making a master calendar form with five rows of seven
boxes. (After all, some months have 31 days and some have 30, but &//
months have 28.) When you create this master (using the grid helps), you
will need to shift the screen window for the last two rows. The master |

created was made with boxes 7 grid units wide by 7 units high.

Save this master on your disk.

Sun Mon Tues wed Thurs Fri Sat
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Next, fill in the calendar with its title and month. Using 12-point type,

enter each date in its proper box. If you use the Align Right option in the

Style menu, the numbers will be properly aligned. The resulting calendar

is ready to print and to put to immediate use.

Conference Room Schedule

March
sun Mon Tues wed Thurs Fr Sat
1 2 3
4q 9 6 7 8 9 10
T 12 13 14 15 16 17
18 19 20 21 22 23 24
25 26 27 28 29 30 31
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0EA 42 ROAD MAPS acPaint |
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Text A
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- Edit

Trying to tell someone how to get to our house over the telephone is like
trying to eat a steak with a straw, so a map is a necessity. Ordinary road
maps are not detailed enough to show people how to get to most residential
areas, so a custom map can be just perfect for enclosure with your party

invitations.
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The key to a useful map is to show where your place is relative to some
major crossroad that can be found by anyone. First, draw the roads with

straight lines using the wide line width.

Cut
Copy
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Once the roads are drawn, you can make your map look very classy by
performing the following trick: Select all the roads with the Selection Box
and then choose the Trace Edges option from the Edit menu. This will

cause all your roads to look more like sireets than lines.
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Finish your map with your place clearly marked, and label all the roads.
The easiest way to do this is to type the road names in some blank area
and then select each name with the Selection Box and move it to its final

destination. Rotate the names as appropriate.

i I 3332 Dayin Ct.
L.
3332 >
) 2
2
g ” Oy || payinct ]
E’ Gowa way
g -
< Easy St.
L ]

Once you have made your own map, you might check with any of your
neighbors who don't have Macintoshes yet to see if they would like maps
also. Who knows? You might pick up enough extra money to buy that

second disk drive!
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A 43 GRABBING - Magraint
o SCREENS

If you were writing a book about the Macintosh, you would probably want
to have some way of saving your entire screen image on the disk. Saving a
screen is different from saving a document, and it can be done directly
from the keyboard. To save the entire contents of a screen, press the Caps
Lock key, hold down the Command and Shift keys simultaneously, and
press the 3 key. (If you play Chopin études, you should be able to do this
entirely with your left hand.) The whirring noise you hear is the sound of
your screen image being saved on the disk. If you want to save only the
contents of the currently active window, repeat the process without the

Caps Lock key depressed.

While the screen images can be from any source—MacWrite, for example—
they can be edited with MacPaint. You can save 10 screen images on your
disk, and they will each be named automatically by your Macintosh as

Screen 0, Screen 1, and so on.
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MacPaint D= /a\ 44 PRINTING

SCREENS

Unless you want to use MacPaint to edit information on a screen, you can
save a lot of disk space by simply printing the contents of your screen or

active windows. Most of the figures in this book were printed in this way.

To print the entire screen (as on page 203, for example), depress the Caps
Lock key, hold down the Shift and Command keys, and press the number
4. If all you want is a picture of the active window, including the title bar

(as on page 32), repeat this process with the Caps Lock key in the up

position.
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Edit

Py

As you work with MacPaini, you may find that you have

I
created a particularly pretty pattern that you might like to

h

incorporate in many pictures—a border motif, perhaps. Your [=)

B L L L

Macintosh has a built-in scrapbook (found in the Apple @

. menu) that lets you save such items to your heart’s content.
(fmT) JamT)
T To save an item in the scrapbook, first select the item, then
. )

Cut or Copy it.

S SEESSESEE85088E0S
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Next, select the Scrapbook from the Apple menu. The scrapbook already

has a few pictures for you 1o use or discard as you choose.

About the Finder...

Scrapbook
Alarm Clock
Note Pad
Calculator
Key Caps
Control Panel
Puzzle
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Once the scrapbook is visible on your display, you can add your new entry

with the Paste option from the Edit menu.
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By moving the box at the bottom of the scrapbook menu, you can “turn”

from page to page.
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Pictures from the scrapbook can be copied and pasted into MacWrite

documents as well as into MacPaint pictures.
You can also copy text from MacWrite into the scrapbook. The only thing

you must remember when doing this is that the text will be saved as plain

text, with no rulers, font, or style infor mation.
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D@EA 46 TO SELL MacPaint @
A MOPED Text | A

Font
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Have you had it with the clutter in your garage? Do you find that you can't
get a bicycle in there anymore and that your car hasn't been inside for five
years? Well, friend, it is time to start cleaning out those old items that you
don't really want. You must be ruthless about garage cleaning or it won't
work. That collection of Early American cinder blocks in the corner should
be chucked out, along with your collection of glow-in-the-dark neckties.
But in your haste to clean house, you should never forget that one person's
junk is another’s jewels. Some of your items can be sold—and that can

make garage cleaning fun.
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Take that old moped in the corner. Remember when you bought it and you
said you would ride it to work every day and you did, except that once you
got caught in a hailstorm and got a flat tire six blocks from home, and as
you walked the bike home in the freezing rain with your fingers frozen to
the handlebar and your shins bruised by banging into the pedals, you
thought your car might be a more suitable vehicle? Remember that? Well,
there is your trusty moped with only a few miles on it, ready to be sold to

one more adventurous than yourself.

To keep your selling costs down, you have decided to sell your moped to a
colleague at work. The best way to announce your intentions is with a

well-designed advertisement.

Remember, if you are going to post your advertisement on the company
bulletin board, it will have to compete effectively with meeting announce-
ments, fire escape procedures, layoff notices, and other corporate trivia.
Bven though your advertisement might consist of pure text, you will find
that MacPaint has some large font sizes that make it particularly

appropriate for selling your moped.

Keep your ad copy simple and to the point. Make it clear w447 you are

selling, fow much it costs, and who is selling it.
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For Sale

Puch Magnum 11
Moped

O 2 hp.engine, auto. trans.
O 2Z-gallon tank

0 100 miles per gallon
under 4000 miles
climbs nills

$700%

Contact Buster Shins,
415-555-1212

0O 0O d O
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Since you are using MacPaint, you can do special tricks, such as using
smaller type for the cents portion of the price and aligning the type so it

looks professionally done.

If your business colleagues aren't interested in your moped, you can post
copies of the ad on other bulletin boards in your community. Before you
know it, you will have a clean garage and enough money to buy something

more practical—like that snowmobile you always wanted.
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MAKING Line Width
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Fill & Line
Pattern @ ‘ Oval

0] /1 0 &) ] > &

As you experiment with MacPaint, you will find that there are tools to let
you create disks, boxes, roundiangles, and polygons. These shapes can

either be empty or be automatically filled once they are completed.
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Fill Pattern menu at the bottom of your MacPaint screen lets you

The

choose from among a wide variety of patterns with which you can fill your

however, that you want your own teddy bear

]

d

shapes. You may fin

1 have it.

pattern and will throw a tanirum if you can

Don't panic—help is at hand.

216



First, pick a fill pattern that you don't want to use anymore in the present
picture. Place the cursor in the pattern and click the mouse button twice.

You will then see the following images on your display.
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The image to the right shows a typical filled region using this pattern, and
the image to the left shows a magnified dot-by-dot view of the pattern
itself.
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If you move the cursor inside the left box, you can change a dot by
pointing to it with the cursor and clicking the mouse button. Each click of
the button will cause the selected dot to turn white if it was black or to
turn black if it was white. Once you have created the paitern you want,

click the mouse in the OK box to save the pattern in the menu.

You can then use this new pattern as much as you like. All of your custom

patterns will be saved when you save your picture.
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While your custom patterns can take any shape you want (within an 8-by-
8 grid), you can create interesting effects by making patterns in the shape
of letters of the alphabet. Traditional computer systems (other than
Macintosh and its like) use characters made from an array of 5 by 7 dots.
Making patterns from these letters allows you to use them to make very

interesting pictures.
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The crafty designers of the Macintosh have made sure that you can make
discoveries of your own with this versatile computer. One of the
discoveries that awaits you involves some characters that aren't
documented in any of the manuals [ have read. Because discoveries are so

much fun to make on your own, I will just give you some hints.
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First, start with a blank MacPaint screen and choose the Text option from
the main MacPaint menu. Select the New York font and 12-point type,
then hold the Option and Shift keys down while typing the accent key (*)
that is immediately to the left of the 1 (one) key. Type this accent key

several times. When you do this, you will see a row of robots appear on

the screen!
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Now comes the fun part. Pull down the FontSize menu and pick another

font size, such as 14-point type. The robots will suddenly change into

musical notes!
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As you experiment with different font sizes, you will see more patterns.
The next thing to try is changing fonts. Some fontis have special pictures
associated with this set of keysirokes, and some don't. See how many

different patterns you can find—there are a lot of them! (A few are shown

on the next page.)
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There was a time, before Macintosh, when books were written entirely by

hand. One of the more artistic traditions dating from that period was the

illumination or decoration of the first letter of the first word of a chapter.

These letters were usually quite large, making them easy to decorate.
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You too can create illuminated letters for your own manuscripis—and
MacPaint is the perfect tool for doing it. The first step is to know the first
letter in your manuscript. Place this letter on your display using any font
that looks pretty. For most letters, the London font with 36-point type is
quite atiractive. Once the first letter is on the screen, enclose it in a box,

leaving some room on all sides of the letter.
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Next, choose an appropriate pattiern from the Fill Pattern menu at the
bottom of the MacPaint screen, or design a pattern of your own. Once the
appropriate pattern is chosen, choose the Fill tool from the main MacPaint
menu. Carefully position the Fill icon so that the solid black portion is
inside the area you want to fill, and click the mouse button. This will give

you a nicely illuminated letter.
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If the Fill icon is improperly placed, you may accidentally fill the area
outside the bozx, the box itself, or the letter itself. If you do fill any of
these, simply select Undo from the Bdit menu and try again. If you are
persistently having trouble, you can work with a larger image of the letter
by using the FatBits tool from the Goodies menu. Use the Selection Box

to encircle the area you want magnified, then select the FatBits option.

This gives you a magnified view of the letter and makes it much easier to
fill.
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Once ihe letter is illuminated, reposition it to the left edge of the screen,
select whichever font and font size you will use in the manuscript, and

type the rest of your first line of text.

Edit Goodies Font
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INCE upon a time, in a valley far from the rest
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This entire line should be copied and pasted into your MacWrite document.

You will then be able to type and edit all the rest of your manuscript using
MacWrite.

The monks never had it so good.
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o=A 51 cusTOM BADGES

Font
- FontSize
Style

Goodies

The name tags we made in Idea 26 are fine for parties, but there are lots of
other places where badges are needed—visitor badges for your company,

name tags for picnics, security cards for the corporate gym, and so on.



Standard plastic badge holders are sold in office supply stores, or you can
grab a handful of them at your next trade show or conference when no one
is looking. The holders I have are designed for badges 2 inches high by 3

inches wide. This corresponds to a MacPaint box of 18 by 27 grid units.

Once you have this size box on the screen, you can make a fancy border

inside the box and finish the master layout of the badge.
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You can then make side-by-side copies of the badge by selecting the badge
image with the Selection Box and using the Copy tool and then Paste to

put copies on the page. You will need to move the MacPaint window (using

Show Page) each time you paste a new badge on the screen.
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Once you have a set of badges on the screen, save this master copy on the
disk. Next, fill in the names of the badge holders, print the badges, and cut

them apart.

Ray O'Lite Carl Stop
Date: 4/28/84 : Date: 4/28/84

.@ccompunwd Visitor| ) 2

"(Smcr[,g Corp. )’; 4
Name:

Harry Hed sk Gerry Atrix
Date: 4/28/84 | Date: 4/28/84
@scompanwd VLSLwr

(Smerhj Corp. j

Name: " :
Anne Howe ~ Skip Towne

Date: 4/28/84 : Date: 4/28/84
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I realize that this book may be too practical and too business oriented, so |
should at least mention some applications for the home. I can't think of a
home that wouldn't benefit from a framed homily. There are hundreds to

choose from: "This house is clean enough to be healthy and dirty enough to

be happy,” “If you must smoke, please don't exhale"—the list is endless.



The key to making a framable homily is to be artistic-create pretty
borders, use the London or Venice fonts, decorate the white space with
litile flowers, and so forth. You can even color your final printout with

watercolor pens for the handcrafted touch.
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Another home idea that makes a fine (if cheap) gift is a set of personalized

bookmarks.

Each bookmark can be personalized for the recipient and may be colored if
you wish. Once the bookmarks are printed and colored, laminate them on

both sides with plastic film before cutting them apart. The easiest way Lo
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laminate paper is to use heat-sensitive laminating film designed for use
with thermal copiers. Bookmarks made in this fashion should last a

lifetime.
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The year flies by so fast, before you know it, it's Christmas. One of the
major problems with Chri$imas is that it is expensive. Christmas cards, for
example, can set you back quite a bit—especially if you send out lots of
them.

One way to keep your costs in line is to design your own cards that can be
printed by your local instant press on pretty paper. Your card should be
laid out to conform to a standard paper size. If you use 8 1/2-by-14-inch
paper, this will produce a card that is 8 1/2 inches high by 7 inches wide
when folded.
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You need to design two images for your card, one for the front and one for

the inside.

——
-

No "L°
frorn

Dr.and ITIrs.
Mark Miwurds

——
-
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Once these images are printed, cut them out (with scissors) and paste them
on an 8 1/2-by-14-inch piece of paper exactly as you want them to appear
on the final card. Take this master to your print shop and have copies run
off on heavy colored paper for your closest hundred or so friends, and you
will still have plenty of money left for my gift. (My shirt size is 15 1/2,
34-35).
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Font

FoniSize

Style

Perhaps you don't celebrate Christmas, or you felt the card in Idea 54 was

too religious. No problem—the generic card should handle the holidays just

fine.

Think of an idea that will appeal to all your friends. Even for serious
sentiments, you'll find that humor can serve very nicely. Come up with an
attractive design for the front and a "punch line” (in this case, a "holiday

punch” line) for inside, and let Mac do the rest.
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Robin de Cradle
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What? You want more cards for other holidays? Oh, all right—but don't

blame me if greeting card companies go out of business!
If you want to make personalized birthday cards, you can buy some pretly

blank paper that can be loaded into your Imagewriter printer one sheet at

a time. This is very handy when you remember that you forgot your
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spouse’s birthday was today but all the stores are closed and you'd better
have a card in your hand when you walk in the door or it is going to be
peanut butter sandwiches for a year. At times like these, a custom

birthday card can save the day.

Birthday Greetings
to the one who is
Dearest to My Heart

Dear One,
On this special day
1 knew that no
store—bought card

could convey the
[ove 1 have for you,

L5
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Greetling cards, gift cards, and wrapping paper can end up costing more
than your gift if you aren’t careful. And yet, a gift card is a nice touch-
especially when you are giving something to someone you would like 1o
remember you in his or her will and you "accidentally” left the expensive

price on your gift.

245



Gift cards can be very simple and should be printed on nice paper so they
can be cut out, folded, and taped or tied to the package (spindling and

mutilating are not advised this year).

X Fop At
-A Special- -
-Gift for -7

AAAAAAAAAAAAA

A A

AAAAAAA

)
( Congrats! )

|3
c:i;qu

On Your New

\ Mac!! )
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Print

Using MacPaint for gift wrap designs doesn’'t make much sense unless you
are wrapping small gifts such as diamond rings, gold watches, or that
special bar of soap you took the last time you stayed at the Drowsy Lids
Motel. For gifts of this size, you can use MacPaint to make quite nice
custom gift wrap. Make your own patterns, even personalize the gift wrap
if you wish (see the sample on the next page). Once again, this is an appli-

cation for which you might want to use colored paper.
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A Special Gift for a Musical Friend - Happy Birthday,Mozart A Special Gift

FRRPRPRPRPRARANIERININIENRIINIINTTNTINT.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Special Gift

FRPRPRPARANANINLRINIINIINIINIINIIINTNNT.

A Special Gift for a Musical Friend - Happy Birthday, Mozart A Speciai Gift

RIRPBRILRPRBIRINIINRIRINRINRIIEN353073.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Special Gift

FRIRNRBRNIRARARLRIRLRLERIERIERIRLIHLNI1.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Special Gift

JIRLNRINRIRANRIRNINRIRINRIBNIPNEILRNNA.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Special Gift

JINRBINNRNNRARRRRALNRALRARRRNRIRIBLRIAILA.
A Special Gift for 8 Musical Friend - Happy Birthday Mozart A Special Gift

RRLLRRNIRNRBARRRPIRRRBIRRR/RNNIIBRRAS.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Special Gift

FRRBRIBANRARPRRARIRRARLRNARAIAARLRKEA.

A Special Gift for a Musical Friend - Happy Birthday Mozart A Speciai Gift

FLRRBRRIBRRPBRRPBRRBLBRPRRBRRRRARRRS.

A Special Gift for a Musical Friend - Happy Birthday,Mozart A Special Gift

FRNJIRBRNRARARIANIRRRBRARIARARARAAARLRA.
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The Spray Can lets you airbrush solid areas (black or white) or even

patierns on the screen. To see how it works, seleci a pattern from the
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Fill Pattern menu and select the Spray Can. As you hold down the
mouse button and move the can back and forth, you will see your pattern

start to emerge on the screen.

This is such a nice tool that it is worth playing with by itself. It can be

used 1o create interesting patlerns for many types of pictures.
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While most of your MacPaint artwork will be displayed in fine oak frames,
you may want to avoid the cost of framing your lesser efforts. In this case,

you will most certainly want 10 create your own custom picture borders.
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Chapter 5
FORTY-ONE MORE WAYS
TO ENJOY YOUR

MACINTOSH
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When [ was a kid, I used to enjoy working with puzzle books that my folks
would buy for me. I think they bought me these books to keep me out of
trouble. It didn't work, of course, but their intentions were noble, if

misdirected.
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Anyway, one of the puzzles I always liked was the one that had a message
hidden in something that looked like a bar code (only we didn't have those

when | was a kid). The puzzle consisted of a picture like this:

And you were supposed to read what it said. The trick to reading the
message is to hold the paper edge-on to your line of sight and look down
the page with one eye closed. By looking at the image at this angle, it
becomes easy to read. You probably have ~eithe»r read the message or gone

to the next idea by now.

In case you are still with me, I thought you might want to know how you
can make your own hidden message of this sort—saying anything you want
(you sly devil, you)—for inclusion with your next letter to your Aunt

Mathilda. As is anything else I am able to accomplish before noon, it is
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quite simple 10 make these messages. Using MacPaint, choose the Text
option and write your message using |2-point Geneva (simple fonts and
uppercase letters work best, although you should try others 1o see how
they work for you). Once you have your selection on the screen and have
proofread it for errors, select it with the Selection Box, making the top

and bottom boundaries as close to the text as possible.
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Next, you want to streich the text downward as far as you can. To do this,
move the cursor inside the selection box near the bottom line, hold down
both the Shift and Command keys at the same time, press the mouse

button, and stretch the selection box down as far as it will go.
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Let up on the buttons and, vos/4, you have your very own puzzle, ready to

print and to astound your friends and neighbors.
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While we are on the topic of puzzles, we musin't ignore the riddle.
Collections of riddles abound, but think how much fun it would be if you
could create your own collection. At least you would know the answers,

even if no one else did.

Of course, any self-respecting collection of riddles has to have the answers
included, and the strategic way to include answers is to have them appear
upside down. (As an alternative, you could have them appear in Yoruba, or

some other foreign language, but upside-down answers are more common.)
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Using MacPaint, you can write the riddles in 14-point type and write the

answers in 9-point type. Once the text has been entered, select each

answer and rotate it twice, which turns it upside down.
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What has six wheels and flies?

yon ebequeb v

Why does a bicycle have two wheels?
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What is black and white and red all over?
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What is the meaning of life?
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One of the greatest geniuses in history was Leonardo da Vinci. One of
Leonardo’s traits was that he wrote from right to left, so that you had to
use a mirror to read his writing. On the outside chance that you think
there is a correlation between brilliance and mirror writing, you should
know how to do mirror writing with your Macintosh. The key to this
practical application is first to Ltype your messages using MacPaint. Next,
select your text with the Selection Box and use the Flip Horizontal tool
from the Edit menu. This will immediately transform your message into a

mirror image that you can print and use to impress your friends.
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" If you have any friends named Medici, be sure to show them this trick—

they will be very impressed.
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One of my favorite toys is the kaleidoscope. It has always amazed me how
a few mirrors and a few pieces of broken colored glass could be assembled
to produce a device that makes such pretty images. It also amazed me
when [ found that, for only a few thousand dollars more, I could create

kaleidoscopic images on a display screen—with the Macintosh.

Goodies
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Kaleidoscopic pictures can be painted with the Paint Brush tool from
the main MacPaint menu. If you haven't used the Paint Brush before,
experiment with it. You can choose brush shapes from the Brush Shape

item in the Goodies menu.

UGS Font FontSize Style

264



In addition to letting you choose a new brush shape, the Goodies menu
has another selection called Brush Mirrors. The mirrors are the tools that
let you create kaleidoscopic images. When you are ready to create a
kaleidoscopic pattern, select the Brush Mirrors entry and you will see

this image on the screen.

UGG Font FontSize Style
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By clicking various lines with your mouse, you will be choosing the axes at
which the mirrors will be located. For our pattern, I will choose the
vertical and horizontal mirror. Once you have made your selection, select
OK to return to your drawing screen. Now, if you start drawing a line, you

will see three copies of your line being drawn in the other quadrants.
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Brush mirrors let someone with little artistic talent create quite pretty
pictures. Once the lines are drawn, you can fill the spaces with attractive

patterns to complete your masterpiece.
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MacPaint IDE/A 65 ORIENTAL
Pencil cARPETs

Selection Box

Pattern

Fill Filled Rectangle
Rectangle Goodies

Line Width .File

Oval Edit

If you have a lot of time on your hands (and who doesn't these days), you

might want to use your Macintosh to create Oriental carpet patterns.

And, then again, you may not.



But if you do, you should know that you will have to create only one-fourth
of the pattern—your Macintosh will gladly fill in the rest. To start, draw a
rectangle that represents the upper left quadrant of the carpet. Start by
creating the border pattern, then fill in the rest of the carpet quadrant

until you have the design finished.
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At this point, you have o do a little fixing up in order to make your whole
carpet fit together smoothly. What you need to do is remove the lines at
the right and bottom edge of the carpet. You can perform this chore using
the white Fill Pattern and the Filled Rectangle. Choose the dotted line
from the Line menu for the boundary. Any time this line is used, the
boundary of a filled pattern is filled with the patiern as well, rather than
being left black. By drawing two filled rectangles of solid white, you will

be able to erase the left and boltom lines.
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Once this chore is finished, place a selection box around your pattern and
press the Option key as you move the image to the right. A copy of the
original will be left behind. If you now select Flip Horizontal from the
Edit menu, the image will be reflected into the proper orientation for the

upper left quadrant of the carpet. Position this part until it is in place.
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Repeat this process by holding down the Option key before moving the
image to the lower right quadrant, and select Flip Vertical to make this
part of the carpet. By doing this once more (with a horizontal flip) you will
have finished the entire carpet pattern with only one-quarter the effort
needed to draw the entire shape! However, your carpet pattern will

have some gaps in it that need to be lilled in using the Pencil tool: Select
FatBits from the Goodies menu for a close-up view. The Pencil can be
used to flip the color of a dot from black to white or white to black with a

simple click of the mouse. Use this tool to fill in the pattern wherever you

need to.
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If you then print this pattern and fold it into a paper airplane, you will

have made a flying carpet.
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@ veckant o2/ @6 RUBBER

P Lasso STAM PS

You can use any picture you have drawn as a stamp to draw many copies

on the page. First, draw your shape, then select it by using the Lasso tool

from the MacPaint menu to draw a line completely enclosing the shape.
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Once the line is completed and you lift up on the mouse button, any objects
inside the line will be selected at z4e/r boundaries, rather than at the
boundaries of a selection rectangle (which is why you used the Lasso and

not the Selection Box).

You can then stamp lots of copies of this image around on the screen by
holding down the Option key and dragging the shape around on the
screen. Release the mouse button and reclick it at each place where you

want to leave a copy.
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When you're through making happy faces you may want to try:
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The rubber stamp idea can be extended 1o create needlepoint patterns.
First, set the Grid option, then create a small cross image using the Line
tool. Make a border for your picture, select the cross image with the
Selection Box, and stamp copies of it wherever you want it to appear.

This is an application that can look nice when colored.
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Though they won't keep you warm at night, quilt patterns made with
MacPaint can be quite attractive. All you need to do to make these

patterns is create a quilt grid on the screen, like the one on the next page.
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Idea 68

Next, fill in each of the squares with appropriate fill patterns. You may

want to make your own patterns to make your quilt distinctive.
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Here's a quilt that uses five patterns. If you rotate one pattern you'll
create the illusion of many more.
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They are found in Games magazine; entire books are devoted to them;

and I can't figure most of them out. What are they? They are "wordies -

puzzles that contain hidden messages.
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How many can you read? "High on the hog"? "Pie in the sky”? “High
noon”? "Hiccup” (hic up)? "Read between the lines”? "London Bridge is
falling down"? "Going around in circles”? “A stitch in time”? "Up to no
good”? "Down in the dumps”? “High on the hog”? “Drop in the bucket”?

“Upstairs”? Well, you have the idea by now, so make some of your own!
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@ vacrant 524 40 PIN THE TAIL

‘é Paint Brush ON THE DONKEY
P Lasso

Edit

By now you are probably wondering why I haven't included any video
games in this book. Well, folks, your wait is over. Yes, you are really going
to celebrate another birthday, and a few of your good friends are coming Lo
your house to have a party. Imagine their surprise when you announce
that you are all going 1o play a game of "Pin the tail on the donkey —on the

Macintosh.
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Well, it isn't that hard to do. First, you need a Macintosh with MacPaint
and a blindfold. Draw a donkey (without tail) near the middle of the

screen.
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Next, draw an appropriate tail and select it with the Lasso. You should

Copy it, just in case it gets lost by accident. Next, blindfold the player and
lead him or her to the mouse with the button already pressed and the tail
ready to move. Spin the player three times, hand over the mouse, and let

the player try to get the tail in the right place.
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And to think that you doubted the utility of the Macintosh!
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Have you looked at the cost of play money lately? Given the fluctuations in
our economy, we would sometimes be better off using the real thing. But
there are many occasions when play money is invaluable—such as when
you are making your own board games or when you want to give a special

gift to someone.
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As with so many other useful applications, play money is best made using
MacPaint.

Redoemable
20 trips to the by benrer for
trash can Prince Frad trash removal

Good for one
menl at the PPY
‘ rant of Anniversary
your choice
| Cynthisen Crock |
S

A special gift
from your

parents, if you
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Pattern

Fill &
Spray Can :'.

Paint Brush ﬁ

Goodies

HH

I know the feeling well: Your sense of social justice swells within you until
you know you will burst if you can't express yourself in public. So you run
1o the basement, find a can of spray paint, and then go looking for a blank
wall. Of course, you may find that others have beaten you to the prime
locations and all the wall space is taken. Also, the local police may not
share your concern for justice and be more concerned with the fact that

you are defacing property.
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The solution to this problem is to spray paint on a picture of a brick wall in

the privacy of your own home using your very own Macintosh.

Step one involves filling the page with an image of a brick wall. Fill the

window with the brick patiern from the Fill Pattern menu.
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Then shift the window down using Show Page 1o fill the second part of
the window. Once you have your bricks in view, select your Paint Brush

or Spray Can and, using the solid black pattern, write the message that

burns inside you.
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There, that feels better now, doesn't it?
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MacPaint D@E& 73 THE

ﬁ Pencil PUNISHMENT

P Lasso

Do you know some poor child who is confined in a classroom with a teacher
who doesn't think that putting gum in Alicia's braids is very funny? We all
went through school knowing at least one teacher that strict. And we all
knew that we would be punished by having to write sentences 50, or 500,
or, when we mixed cement in with the muffin mix and the school cafeteria

had to extract their Mixmasier with a jackhammer, 5000 times.

Well, now that Macintosh is here, this task can be carried out with far
greater ease than ever before. The first step is to use MacPaint to write

the sentence once.
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Next, select the sentence with the Lasso and, using the Option key, make

copies of the sentence on the page.
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Before you know it, you will have the assignment completed! Of course,
you may have to work hard to convince your teacher that you wrote all

these sentences by hand. Perhaps other styles would be more convincing:

I wr// WOEK on my QUAE skills!
I 77/ WORK on my MAE skills!
I il/ WOER on my &G skills!
I /7 WORKK on my MHAE skills!
I wi// WORK on my WAE skills!
I rrl/ WOER on my MBAE skills!
I /7 WORR on my HHAE skills!
I /7 WOEK on my MAE skills!
I sl WOER on my M0AE skills!
I gr/// WOER on my B0AE skills!
I rl/ WORK on my Wae skills!
I il WORK on my MA@ skills!
[ s/ WOREK on my &G skills!
I i/ WORK on my MA@ skills!
I /7 WORK on my MA@ skills!
I il WORK on my WAE skills!
I wi// WORK on my &G skills!
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MacPaint IDEA 74 HALF WORDS

Selection Box

Text

Can you read the following sentence?
Thic 1 a teet nf vvonir readinag el

This half sentence shows that we don't need 1o see an entire letter 10
recognize it. In fact, we appear Lo be able to read just fine by looking at
the top half of a word. To experiment with half words of your own, just

type a sentence and select the lower half with the Selection Box.
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Now that you've had some practice, try your skill at reading

these:

Vi can tiime a niann hait v ran't tiina fich

NAN't swenrery if vair inh ic ecmaftt
AnAd ssnnir rowardc are fow
RPememher that the miahty nal

Waec nnre 2 mit tlive vz

A fixvz anAd a flea in a fls

Were imnricnned cn what rriiid thesr An?
QLaid the fivy T et 1< flesl”

"Tet 11 fivl” caid the flea

AnAd thev flew thraich a hnle in the flie

I acked mv mnthor far fiftyv reantc
Tn cee the olenhant nimn the fence
He inimned cn hich that he tnnicheAd the v

AnAad nevver rame hark 1ill the Frirth Aaf nivy

A hnarce and a flea and t hreo hliinAd mire
Qat An a rirhctane chnnting Airce

The harce he clinned anAd fell Aan the flea

The flea caid "Whnnane thoere'c a hnres nn mol”
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DEA 19D INVERSIONS MacPai

Line
Line Width

Selection Box

Artist, computer scientist, and generally interesting and nice guy Scott Kim
has written a book called /nversions (Byte Books) that consists mostly of
words that he has written so that they look the same upside down as right
side up. He also experiments with other inversions, including mirror

images. For example, the following is an inversion of my son’'s name:

NarIeyY

........
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When making inversions yourself, the Macintosh can be a valuable tool

since it lets you select letters and mirror them or rotate them.

For example, suppose we wanted to make a never-ending loop out of the
word TREE. One way to do this is to make a stylized T so that it looks like
an E when it is rotated 90 degrees. We can then write the word TREE

using these characters.
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Next, we can select the REE portion of the word with the selection box,
make a copy of it (by pressing the Option key before moving it), rotate it
90 degrees (with the Rotate command in the Edit menu), and place it at

the correct position.
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By repeating this process iwice more, we will have our endless tree.
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These can be copied 1o produce a complete forest!
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No, we haven't forgotien about MacWrite. In fact, I was just getting to it
when you started to read this project. What better way to keep your
friends and relatives up to date than with a Chrisimas letter? Of course,
writing such a letter by hand is time-consuming, and running copies off on

a mimeograph machine lacks class—but that is why we have Macs!

First, find a quiet corner and page back through your desk calendar, noting
down the major events of the year (Jimmy's acting debut as a giant beet,
the day the rabbit got loose and left "surprises” all over the living room
rug, your speech 1o the P.T.A. on controlling toxic underdesk gum deposits,
and so on). Then weave the details into a nice homey letter you can

enclose with your Chrisimas cards.
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Dear Friends,

Well, wouldn't you know it, another year has passed and it
is time for us to celebrate the holidays again. What a year
it has been for us! Fortunately, Cousin Fred was released
from the slammer last week. Welcome back Fred! Don't
forget, you owe us Christmas presents for the last 15
years! (Just kidding.)

finyway, Lulu Bell arrived last week after spending her year
wildcatting on the North Slopes, and Pricilla finally made it
big in the bottie collecting business (finding lots of twenty-
centers, Pricilla?), so we have had a good year, even if
Dingus did get hit by lightning last May. He can still jump-
start a car with his bare hands, and that's been mighty
handy this winter, | tell you.

Anyway, | was talking to Ronny about his Washington job.
Seems someone in government wants to reise postal rates
again. | said, "Gosh all getout” (Ronny doesn't like strong
language, but what the hay), “why don't they just make the
stamps smaller!" He thought that was a swell idea and is
passing it along.

Well, I'll bet it was a good year for you too, and we all want
to wish you the very best for the upcoming year and many
more to come.

Best wishes,

Manuel Overdrive
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Have you ever noticed that either no plants will grow in your garden or
everything grows in abundance? Take tomatoes, for instance. A good
tomato vine will keep you supplied quite adequately. Twenty vines will
overwhelm you with tomatoes. Once you have had your fill of fresh tomato
juice, tomato sauce, tomato pancakes, fried tomato skins, tomato seed
bread, and all the other delicacies that can be made with this plant, it is
time to share your blessings with your friends. This means canning your

sauces, tomatoes, stews, and jellies and bottling your tomato wine.
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Of course, your efforts will make much nicer gifts if your jars don't have
Snerdly’s Industrial Strength Peanut Butter labels on them. So you will
have to make your own labels. Thank goodness for Mason jars and
MacPaint!

Uncle Rred's
Tomato Wine

Estate Bottled at the
Chicago Vineyard
Fred Zucchini. winemaster

Winner of the 1984 award for perseverance
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Have you ever taken part in a chain letter? It was a lot of work, and it
didn't pay off, right? Well, now you can get even with all your friends by
starting a chain letter of your own. The first step is to compose the letter

in such a way that no one will dare break the chain.
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Dear Friend,

You are the recipient of a letter that will change your life
forever. You are part of a chain of humanity that reaches
across the globe. You could break this chain by failing to
continue this letter on its way, or you can snsure everiasting
peace by sending the contents of your checking account to the
first name on the list below, crossing off this name, adding
your name to the bottom of the list, and sending this letter to
50 of your best friends.

Remember, if you break the chain, you will start global
thermonuclear war, and I know you don't want that on your
conscience.

Melba Toast
36 Snails Place
Post Office, VT 72707

Patti O'Furniture
735 Dayin Ct.
Brief, UT 08090

Sandi Beach
30 Simpleton Brook
Stoned Clover, IT1] 88834

Syl Able
12 Grammar Way
Parsing, NY 13579

Steffin Rightalong

20 Flower St.
Thistle Pass, WY 78111
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The next step is to take advantage of the Copies option when you select
Print from the File menu. To set the number of copies you want printed,
click your mouse in the Copies box, press the Backspace key, and type
the number of copies you want. Once you have done this, select OK to get

your letters printed.
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can ensure everlasting peace by sending the contents
of your checking account to the first name on the list
below, crossing off this name, adding your name to
the bottom of the list, and sending this letter to 50 of
your best friends.

Remember, if you break the chain, you will start
global thermonuclear war, and I know you don't want
that on your conscience.

IMelba Tost
36 Snails Pace
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"Have a boy, it’s a cigar!” Yes, if you are welcoming the addition of a new
baby, cat, dog, goldfish, or tarantula, your MacWrite-produced birth

announcement will make sure no one ever forgets the event.

Announcing

the birth of
Six Cute Kittens
to
Miss Muffy Cat
and
Mr. AL E. Cat
on May 3, 1984

No gifts, please take cats instead.
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The loss of a pet is no laughing matter. Even as you are checking the local
SPCA and animal pound, you should be getting flyers posted around the
neighborhood letling people know that you have lost a pet. Because of the
larger fonts available, MacPaint is a better choice for creating such
announcements than MacWrite. If you have a photograph of the missing
animal, you may want to glue copies on the poster. Some local merchants
make bulletin board space available for such announcements, and a

carefully crafted announcement will draw a lot of attention.

$50 Reward

for the return

of my pet
Rattlesnake

LLast seen on May S, 1984
Call Chet Mark
415-535-1212

if you have information or

have found my snake
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After many years of hard work, you have finally managed to rise in the
ranks so that you now have your very own desk. What better desk
ornament can you imagine than a tasteful name plaque to identify your

desk as your very own? And, of course, what better tool for the creation of

such a wonder than MacPaint?

Once you have completed your nameplate, go to your local paint and hobby
store and buy a nice wood block that you can use as a base for your name
and then make your plaque professional by using your latent skills as a

decoupage artist.



Carl Stop

Rodeo Rider
“The Stop bucks here”

On the other hand, you may have an entire office of your own, or one you

share with some colleagues. In this case, a label for your door is more

appropriate.
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Limerick Copyright Law Specialists
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Imagine the turmoil Bach must have felt, composing his scores by hand,
purely by the light of burning Vivaldi manuscripts. Yes, we have come a
long way since then, and the Macintosh might have been one of Bach's
favorite toys, were he still around. Well, you have the tool he didn't have,

30 you can have an easier time composing music than he did.
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To transcribe a score using MacPaint, first create a staff of five lines, each
of which is 2 grid units from the next. Then use the Filled Oval tool to
make some 2-grid-unit circles and fill these in to make notes. If you have
a steady hand, you might want to draw the treble clef in the right place on
the leger lines. (I always have treble doing this—probably because 1 am
not fully attuned to drawing with the mouse, but 1 have made note of my
progress. The bass clef is easier to draw—something I find quite fishy.)
Notice that the notes have been drawn in an out-of-the-way location where

they can be easily selected and moved.
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To compose your music, enter the time and meter, select you notes with
the Lasso, and compose away. Press the Option key when moving a note
so that you never lose your original. After your notes are in the correct
places, you can fix up any lines that are obscured by the notes and put in
the bar lines.
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“DEAR JOHN” LETTER Font

Style

Ah, I know the feeling well-hardly a week goes by without receiving a
marriage proposal from yet another admirer, and you want to say no
gracefully without offending the writer or your spouse. Well, what better
way to do this than with a letter composed on the Macintosh? Because you
will need to send so many of these, you will want to make a form letter

that you can modify for each recipient.

The letter on the next page should do the trick nicely.
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Dear John,

I want you to know how touched I am at your
daily gifts of Godiva chocolates and by the fact
that you have sold your home in Vermont
and moved here to Pratfall, Oklahoma, just to
be near me.

In fact, I was telling my dear husband,
Gunther, about your generosity and he said
that you sure were somse kind of guy! In fact,
he said that you could send me chocolates as
long as you want (as a weightlifter, he likes
an occasional snack, and the chocolates come
in very handy for that).

Unfortunately, I am unable to run away with
you because Gunther and I are moving to
Nome, Alaska, next week. Gunther sure
would like you to move there with us, if you
keep sending candy. "Heck," he said, “let him
stay here and send the candy to us!" Isn't that
cute!

Wsell, John, I have togo now. I'm sure you
understand. I'm sorry we didn't talk more
before you sold your house and everything,
but I'm sure you will find a job here in
Pratfall soon. Gunther will be leaving his job
at the slaughterhouse, and with your degree
in surgical medicine and ail, you will
probably be able to work there.

Fondly,

Tanya Hyde



IDEA 84 GENERIC MacWrite
LOVE LETTER

On the other hand, perhaps you want to win the hand of that special
person. MacWrite will be just fine for you since it lets you choose a nice
romantic font (such as Venice). Use 14-point type so the text won't be too

blurred from the tears of joy that are likely to drop onto your missive as it

is being read.

Denrest,

Did you see the moon last night? 1 stood
moon rise ever higher in the sky, just as our
love grows stronger every day. And as the
wail of the ambulance siren rang in my ears
as my shivering body was being taken to the
hospital, 1 thought of your sweet voice. The
heat of the warm blankets reminded me of
your warm lips, and 1 Rnew that 1 couldn’t
be apart from you.

And so, my dasling, know that my love for
you is everlasting, and, for God's sake, don't
stand out in 40 degrees below zero looking at
the moon for 4 hours. They will send you to
the funny farm for evaluation.

With all the love in my heast and soul,

Lyle Lotte
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vecbaint 157575 &5 MAKE YOUR OWN
Rectangle POSTAGE STAMPS
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Commemorative stamps never seem to honor the topics that really matter—
the invention of the backhoe, for example. Well, you can fix all that by
designing your own stamps using MacPaint. Of course, your stamps can't
be used as legal postage, but this shouldn't matter if you only want to paste
them in your collection. Imagine your friends’ responses when you ask

them if zAey have the "deodorant soap” commemorative issue!



Who knows, you may find stamp designing more fun than stamp collecting.
(Who knows, you may find root canal surgery more fun than stamp

collecting.)

To make your stamps, make a fill pattern image that looks like the perfora-

tions along a stamp border.

& File Edit Goodies Font FontSize Style
. Idea 85
1N
é » NAAAAAANAY
B NANAANANY
BER RAAAAAANAAL
. Verey
AAANAANANY
D AN
= (_ ok ] [(cancel )
O
O
<
—
) R AR RIOD
| ] i ¢ e =

321



Next, fill a long rectangle with this pattern and select a strip of border that

is longer than any stamp you want to make. Once the border is selected,

cut it for later use.
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Next, design your stamp image and frame it with a rectangular border.
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Finally, paste appropriately rotated (and trimmed) copies of the stamp

edge pattern around the outiside of the border to complete your
masterpiece.

Deodorant Soap

Seen any good stamps phi-lately?
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If you are from a large family, you can justify the purchase of your
Macintosh (with family donations) by using it to compose a family
newspaper. Families tend to get spread out all over the world, and a
family newspaper is a nice way to remember everyone's birthday, to
distribute favorite recipes, and to share old and new experiences that keep

the family together.

If you are going to create a family newsletter, you should create a nice title
block using MacPaint and print this out with the proper issue number and

date.

The Tastic Times

Vol | All the news we gel/ No 4
Fran Tastic, Editor

324



Next, compose your newsletter text using MacWrite and print the text out

in 3 3/4-inch-wide columns.

Well, here it is, spring again! Time for another
family newsletter. Now I know that all you
Tastics in Hawaii are mad at me for your
newsletters arriving all wet. You see, I thought
it might be a good idea to hand-deliver them to
you, since the weather here in Anchorage isn't
too nice in February, so I just packed up and
flew myself to your part of the world. Of
course, | forgot that your newsletter copies
were with me when we went whale watching,
and when our boat overturned, things sort of
got wet.

But this copy should arrive dry and on time.
Speaking of on time, remember the Tastic
marriage in Indiana I reported last time? Well,
three months later, guess who just had twins!
Can't say we Tastics don't move fast!

Those of you who helped us gather the
information on Great-great-grandpa Tastic's
role in working for the British during the War
of 1812 will be pleased to know that all treason
charges have been dropped. It appears that it
was all a mistake. He thought they were
bringing torches to the White House to help the
President read better at night - an honest
mistake.

And let’s hear it for the Tastic family in
Forktine, Wyoming - your very own Chick 'n
Ship franchise! Good for you.

We've got lots of goodies in this issue. The
results of the pig naming contest have come in,
and some great recipes that use raw sunflower
seeds grace the last four pages this month!
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Once the columns are printed and proofread, you can cut them apart and
glue them in place side by side on the title page. Each new page should
have the page number centered at the top and columns of text from top to
bottom. Add little graphic embellishments at the end of articles, include
cute cartoons, and encourage recipients to contribute to making the
newsletter a success. Ask for favorite recipes, anecdotes about the oid
days, birth and marriage announcements, job promotions, and so on. You

will be surprised at the number of things your family has done!
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IDEAY 87 STRING ART MacPaint
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Some call it aestheometry, some call it boring,
<\ but I call it string art—the preity patterns that

S04 are made by wrapping string around pegs so
that each strand intersects the next to produce

the illusion of graceful curves.
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To see how it is done, make the following grid pattern on your MacPaint

Edit Goodies

Font FontSize Style

Idea 87
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Then, using the Line ool and the thin line width, connect pairs of points

to prdduce a pretty pattern. There is no limit to the patierns you can

create this way, and this is a good Macintosh activity for people of any age.
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DEL 88 BUMPER MacPain

STICKERS Text
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Line Width |

You may as well express yourself; everyone else does. And what more
American form of expression can you imagine than the ever-present
bumper sticker? Of course, you are limited as to the size of sticker you can

create, but most people won't bother to read it anyway, so it really doesn't
matter.
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Small Bumper

Stickers Hide
Deep Thoughts

You can make your sticker look more professional by printing it on
adhesive-backed colored paper. Be sure that you use a label paper that

can be removed if you change your views!
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Text
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We are continually inundated with cautionary notices regarding everything
from crossing the street to carrying bombs on airplanes. It is time for you

to create a few cautionary notices of your own.

........

Font
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Using MacPaint, start with a farge circle, draw a picture of the thing you

want to avoid, and draw a wide diagonal line through it.

No piano
playing

No “l love

anything”

bumper stickers
allowed

S

See, you can make a difference!
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If you are a busy business executive like me, you know that the best way
to make progress is to delegate your work to others. Rather than write a
complete memo stating your desires to your subordinates, you can use a

handy action list on which you check off the tasks you want carried out.
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Such lists are easily made with MacPaint.
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To:

From:
Romp N. deHay

Action:

Read and review

[] read and weep

Read and destroy

Destroy before

reading

Transiate into

English

Prepare my

position on this

Copy and send to:
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FontSize Text § A

Style Font

If you tinker in the kitchen, you probably enjoy sharing recipes with your
friends. Unfortunately, lots of recipes end up being written on scraps of
paper and are very hard to read. Imagine my surprise when I discovered—
too late—that "1 c¢. gr. pepp.” meant one cup of sliced green peppers, not

one cup of ground pepper!
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MacPaint can help you make your recipes look preity and can make them
easy to share with others. Many people keep recipes on 3-by-5-inch file
cards. In keeping with that format, create a blank 3-by-5-inch card with
MacPaint. Using the Grid option, draw a rectangle 27 grid units high by 44
grid units wide. You can use the Roundtangle to make a tab at the top of

the card for the name of the recipe.
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Next, pick a readable font and enter your recipe on the card.

If you print your recipes on heavy paper, they will fit in your card file

perfectly!

Aunt Mary's Mud Pie L_

4 c. adobe clay
49 c. water
1 tsp. olive oil

Mix all ingredients in a large pot until
consistency is uniform. Bake in the sun
for 6 hours. Serves 20.
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A calligram is a pattern made from a word such that the pattern looks like
the thing the word describes. Because MacPaint lets you place letters

anywhere you want on the screen, you can create calligrams quite easily.
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PEA 93 SELLING MacWiie
A HOUSE

Selling your own home can be a rewarding experience (provided you don't
want to live there any more). Your Macintosh can be used to prepare a
nice flyer. MacWrite is a good tool for flyer creation, and your copious use
of rulers will let you center what should be centered and adjust the
margins o make a very professional document.

Three-Bedroomn Home

$240,000

17 Basketball Ct.
Dribble, Indiana

Fearures:

Open-air kitchen

Compact living space (900 square feel) - easy 10 keep clean
Free parking only two blocks away

Wood heat

Easy-maintanance yard (dandelion field)

Assumable 30% loan

Running water

Nearby rest rooms available

Contact:

Jacques Absorber, 417-555-1212
If your house is quite photogenic, you may want 1o glue a picture of it on

the flyer so that potential customers will know what you are selling.
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Font
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If you are running a small business, you may want to have small brochures
on your products that can be handed out to prospects when they visit you.
Rather than hand people a large sheet of paper, you can create a nice
folded brochure that is made by printing your information on both sides of

a sheet of 8 1/2-by-14-inch paper and then folding the paper twice as

shown: \\4 /
BN N

This folded sheet gives you eight panels on which to place your company’s

information.



Take a blank sheet of paper and fold it into the final configuration so that
only two panels are exposed. The first panel should be used for the
company name and general infor mation about the products. The back
panel should contain your address and phone number or the names of your

distributors or dealers.

Goodshow
Industries
Hena
for more information| Goodshouws,
contact President
Xena Goodshow Catalog
Goodshow Ind of Products
12 Ceeyu St.
l.oter, AL 98232
514-555-1212

If you now unfold the brochure once, you will expose two inside panels.
You may want to use these areas to describe features of your products and

general pricing information.

Goodshow our
Industries Features

manufacturer | O —+—"

of fine
0O «—a—r
natural
chicken O~ N—
fertilizer

O "Ne—r

@ T
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If the brochure is unfolded again, this reveals four panels that can contain

detailed infor mation.
Chicken Harvesting
Our Founder, Ranch Procedure E
Hena . 2
features Pricin
Goodshow 9 o
D —_——~——— D\'—"‘"—" L =] as
qwerty fghj jki O —~—a__ 0O ~—~——— S 2 §
dfg sgdgh shdjhg | OO ~_— 0 ~— TS EL
.. . D—"‘“/\" s E o g
shgg gghgjj hhgj O S ze
kijhgghgg ghgg ghjh.

As the prospect opens the brochure, he or she is carried from the general
information about your services or products to specific infor mation and,

perhaps, an order form.

You can create the text for your brochure using MacWrite and print it using
columns about 3 inches wide. Once you have your columns printed out,
carefully glue them in their proper places on a sheet of 8 1/2-by-14-inch
paper and be sure that the brochure looks proper when it is folded. Take
this master to your local print shop and have copies made on colored
paper. You can get a very professional looking document for a very small

investment this way.
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If you have had it with Canada geese flying over your house and want to
do something about their flight patiern, run for a position on your town

council so you can pass an ordinance banning such flights!
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Of course, if you are running for office, you want to be sure that you get
elected. The key to winning an election can lie in your com munication
tools. Your Macintosh can be invaluable in creating brochures, posters,
newspaper advertisements, speeches, travel itineraries, and so on. In fact,
your very use of the Macintosh could probably help get you elected if you
lived in Cupertino, California (Apple's home town).

A Help Stamp Out .
g Postage! g
g elect §
| Bud Ingrose .
g councriman §
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DEA 96 CROSSWORD
PUZZLES
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"What is a four-letter word ending with IT that is found on the bottom of a

MacPaint = €

Text

Pattern

Fill

bird’'s cage?” Yes, crossword puzzles can be fun to solve, even when the

word is GRIT. But just as they are fun to solve, they can be even more fun

to make, using MacPaint, of course.

O

Goodies

" Font
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If you plan on making more than one puzzle, you might want to start by
creating a grid of squares on the screen in which each square is 3 grid units
high.
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Next, make a rough draft of your filled-in crossword puzzle and number
the squares that contain the first letter of each word. Nine-point Geneva

type is perfect for this. You should also fill in any squares that don't have

letters in them.
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Finally, create your list of clues underneath the puzzle itself.

Across: Down:
1. Macintosh maker 1. Natural snack
2. Crunchy fruit 2 Tree-grown hard fruit

3. Rhymes with dapple

4. Famous author of
Macintosh book
(last name)

Once you have done this, you are ready to print your puzzle and send it to

all your friends.
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Font

The combination of MacWrite and MacPaint is perfect for the creation of
custom children's books for early readers. If you can tell a good story, you
can make this story into a custom book by using the child’'s own name
(along with that of the child's friends, pets, and favorite toys). The book

should be written with large easy-to-read type (such as 24-point New
York).
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Once upon a time, Lisa Karr, Ray Bees,
and Sid Down decided to go to the zoo
with Lisa's pet dog Sophocles.
Because the zoo was only two blocks
from Lisa's house, they all decided to
walk there.

“Oh my!"” said Lisa, "We must be
careful when we cross the street!”

Sophocles barked in agreement.

When they got to the first street, the
light was red. "We can't cross now,"
said Lisa. So Sid sat down.

The only problem was that when Sid
sat down, all his money fell out of his
pocket and rolled into the sewer.
This made Sidney mad. He said, "Oh

You can put illustrations on each page or have them appear on separate

pages if you wish.
If the book is for a very young child, you may want to laminate the pages
in plastic so they won't get torn or damaged by wetness. Be sure to use a

“flat finish” laminating film, as the glossy film can be hard on a child's eyes.

A custom storybook can make a treasured gift for which you will be

remembered for a long time.
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A nice activity for MacPaint is 10 make a list of the given names for
everyone in your family and to arrange the list so that the names intersect
at common letters. This can take some planning, but can produce a very
pretty pattern. If you have some family members whose names won't

intersect properly, ask them to change their names.

cleo
t
no_p
virginia
e "M

greg
L
d avid
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. Rectangle
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Just as MacPaint makes a good tool for corporate organization charts, it can
be used for family trees as well. The easiest way to build such a tree is to
start with the youngest generation and move upward. If you find yourself
running out of room, you can eliminate those family members you would

rather forget about anyway.
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Franz Fial Hank Fully Tiny Minute | | Brent Dym
Sacha Pill Dee Cont Val Halla Heidi Ho
Phil Fully N. E. Minute
Mally Fied Nicole N. Dym
— —
Grace Fully | (wade A. Minute

—_—

Jchn
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As an interesting variant on the garage sale, you can raffle off your
priceless artifacts, especially if people think you are working for a
charitable organization. ("Excuse me, I'm selling raffle tickets to raise
money for the Venetian Blind.") MacPaint can be used to create quite
impressive raffle tickets. In no time at all, you will have a clean garage and

some money in your pocket!

3475 | Official Raffle Ticket
for a complete set of

bowling shoes (used)
This ticket ig sold with the understanding that you must accept
the price if you win. The drawing will be held any day now.

ticket ¥ 3475
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I travel a lot, and I am always carrying cameras, suitcases, saichels, and,
when | am flying on commercial airlines, decent food. There are many
places where I need to have identification tags, and MacPaint lets me

create distinctlive tags easily.

Ira Grett
12 Keepyur PI.
Watchit, CO 76534

oA s
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Once you have created your own ID tags, print them out and laminate them
in plastic film. Leave room in your tag design for a cord or strap to hold

the tag in place.

Another idea that you might try is—wait a minute! How many ideas do we
have sofar? 1017 Really? You mean we are done? But I'm just getting

started! We can't stop now, can we?

Well, I guess we can. After all, the purpose of these ideas was to stimulate
you to come up with even more of your own. By now you have more than
mastered your Macintosh and MacWrite and MacPaint. You have actually

found your new computer to be indispensably useful!

Thanks for your attention; it's been fun!
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Macterms

This is a list of Macintosh functions used in this book. The number
of each /dea in which the function is used follows its description.

Apple menu

Closed Curve,
Filled

Edit

About MaclWrite... About MacPaint...
Scrapbook Scrapbook
Alarm Clock Alarm Clock
Note Pad Note Pad
Calculator Calculator
Key Caps Key Caps
Control Panel Control Panel
Puzzle Puzzile
Closed Curve (._?
L=

&2

Cant Undo

Cut 3%H
Copy L
Paste 1)
Show Chpboard

Cut %H
Copy %8C
Paste )
Clear
Invert

Fill

Trace Edges S8E
Flip Horizontal
Flip Uertical
Rotate

U_!."-.‘! i B

The Apple menu has lots of good
things: your scrapbook, desk
accessories, even a puzzle for when
you're bored! Ideas: 4, 14, 21, 45.

The Closed Curve lets you create a
variety of odd shapes. Ideas: 65, 70.

The Filled Closed Curve creates odd
shapes, complete with texture. Ideas:
47, 65.

The Edit menu lets you correct your
drafis like a professional. You can use
Cut, Copy, and Paste to rearrange any
text. If you make a mistake, the Undo
command lets you revert to the
previous version. The Clipboard saves
your masterpieces so you can get to
them when you need them. Ideas: 5,14,
17, 18, 19, 20, 21, 22, 31, 32, 37, 40, 42,
50, 51, 52, 53, 56, 61, 62, 63, 65,70, 75,
85, 100.
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Eraser

File

Em

New
Open...
Close

Save

Save fis...
Page Setup
Print...

Quit

Fill

Font
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London
Cairo
Chicago
Geneva
vNew York

Monaco
Uenice
Athens
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Open...

Close

save

save As...
Revert

Print Draft
Print Final
Print Catalog
Quit

O

o

Chicago
Geneva
vNew York
Monaco
Uenice
Athens

The Braser erases. A double click on
this icon deletes your entire screen!
Ideas: 35, 69.

The File menu manages the files you're
working with. It opens files to let you
see what you've got and puts them
away S0 you can move on to more
important things. It not only lets you
title and store your documents safely
but also acts as a representative to your
printer, specifying paper size, printing
quality, and format (with your help, of
coursel). Ideas: 6, 19, 20, 29, 30, 32,
41, 51,52, 60, 65, 78, 96.

The Fill bucket “pours” in black paint

or a texture within any enclosed area.
Ideas: 33, 37, 47, 48, 50, 51, 52, 57, 60,
64, 65, 68,71,72,77, 81, 85, 95, 96, 101.

The Font menu has a full selection of
typefaces for your document. ldeas:
1,2,5,7,8,9,10, 11, 12, 15, 23, 24, 25,
26, 31, 37, 39, 40, 49, 50-55, 57, 61-63,
69,71,76,77,78,79, 80-101.



FontSize The FontSize menu provides a wide
m selection of point sizes Lo give your
0 polnd document maximum impact. Ideas: 31,
10 33, 37, 39, 40-42, 49, 50-58, 61-63, 69,
2 71,77,78, 81, 82, 85, 88-92, 94-96,
0 98-101.
24
36
48
72
Format The Format menu lets you select
m among a variety of different MacWrite
:'{':ef': luler aids, to allow you to manage rulers,
ide irulers
Open Header !‘ootnotes, page numbers and othter.
Open Footer infor mation tools necessary to efficient
Display Headers document creation. Ideas: 11, 12, 14, 16.
Display Footers
Set Page #...
insert Page Break
Titie Page
Goodies The Goodies menu offers you all the
inside tricks you need to manipulate
W—— MacPaint to the fullest advantage.
FatBits You'll find the options Fatbits and
:2:"!!; Page Show Page essential for everything
attern H
Brush Shape from fine touch-ups to full page
Brush Mirrors tableaux. ldeas: 32*34, 37, 41, 50, 51,
Introduction 64, 65,67, 68,72, 82, 87, 96.
Short Cuts
Hand The Hand moves your work screen
i ? around the document. Ideas: 60,71.
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Lasso

Line Tool

Line Width

MacPaint

MacWrite

Oval
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The Lasso can position an item on the
screen without deleting the art or
documentation that will surround it in
its destination location. Ideas: 70,73,
77, 82, 85.

The Line Tool is used to draw
straight lines. Ideas: 31-33, 37, 38, 42,
47, 48, 65, 67,75, 82, 87, 99.

Line Width lets you select the
thickness of the line you wish to use for
creating rectangles, ovals, straight lines,
and soon. ldeas: 32, 33, 37, 38, 41, 42,
47, 48, 50-53, 57, 60, 65, 67, 68,71, 75,
77, 81, 82, 85, 87-91, 95, 99-101.

MacPaint opens up your new universe
of artistic software. Icons speed you on
your way to beautiful work. ldeas:
31-75,77,79, 81, 82, 85, 87, 89,91, 94,
96-101.

MacWrite is your word processing
specialist. A large selection of fonts,
sizes, styles, and editing capabilities
makes for fast and efficient document
creation. Ideas: 1-30, 76, 78, 80, 83, 84,
86, 88, 90, 92, 93, 95.

The Oval creates perfect circles or
ovals to your specifications. Ideas: 33,
47,65,71, 89.
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The Filled Oval creates circles and
ovals filled with texture. Ideas: 65, 82.

The Pattern Selection Bar allows you
to choose among many pattern styles or
the colors black and white for your fill
pattern. If you don't like the patterns
available, double-clicking any of them
will allow you to create a new pattern
of your own. Ideas: 33-35, 47, 48, 50,
51,52, 57,59, 60, 64, 65, 68,71,72,77,

‘81, 85, 95, 96, 101.

The Paint Brush is used for painting
black or textures. A number of
different brush styles and features are
available from the Goodies menu.
Ideas: 64,70-72,77, 94, 97.

The Pencil draws freehand lines. It's
also useful for touching up close-ups
obtained with the FatBits command.
Ideas: 73, 82, 94, 97.

The Potygon creates empty polygons
to your specifications. Ideas: 38, 47.

The Filled Polygon gives you
polygons filled with texture.
Ideas: 47, 48.
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The Rectangle draws an empty box

to your specifications. ldeas. 32, 36, 37,
39,50-53, 57, 65,67,68,71,77, 85, 88,
89-91, 95,99-101.

The Filled Rectangle draws any box
you want, filled with any texture you
select. Ideas: 34, 36, 65.

The Roundtangle draws a box with
rounded corners to your specifications.
Ideas: 39, 47,57, 60, 85, 91,92, 101.

The PFilled Roundtangle draws a box
with rounded corners and fills it with
the texture you select. Ideas: 47, 85.

The Search feature allows you to Find
mistakes anywhere in your text
instantly and then Change to the new
entry of your choice. Ideas: 3, 28.



Selection Box

Spray Can

Style

vPlain Text
Bold
rtetic
Underline
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Shadow
sSuperscript

® Peinl
10 Point
vi12 Peint
14 Pein
18 Peind
24 Peint

Subscript
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Bold %B
/talic %1
Underline 38U
Cutline %0
Shadom =S

vAlign Left L
Align Middle %M
Align Right 3R

v

The Selection Box is used to indicate
what item you wish to alter.

Alterations can include Edit functions
like cutting, copying, pasting, and
flipping, or options such as reduction
and enlargement. Ideas: 18, 31, 32, 35,
40, 42, 45, 61-63, 65, 67,74, 75, 85.

The Spray Can is for spray-painting.
Spray paint is available in sofid black

or the texture of your choice. Ideas: 59,
72.

The Style menu gives your document
that special touch. Selections let you
make your words bold, italicized . . .just
about any way you want them.

Ideas: 1,2,5,7-14, 23-27, 32, 37,
39-41,50-58,61-63,69,71,77-86,
88-96,98-101.
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Trash

The Text command lets you write in
MacPaint. A wide selection of fonts
and font sizes is available, with options
1o change aspect and proportion in ways
that just aren’t possible in MacWrite.
Ideas: 31-39, 42, 46, 50, 51, 53-58,
61-63,69,71,74,77,78, 81, 82, 85,
88-101.

The Trash Can is always there when
you need it - to create extra room on
your electronic desktop by disposing of
unwanted files and folders. The
Empty Trash command in the Special
menu deletes them from the disk's
memory, creating space for new files.
Idea: I.
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